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SYSTEM DESCRIPTION

Introduction
This chapter provides a brief introduction to the Simrad EQ60
fishery echo sounder system.

Related topics

→ Overview, page 2
→ EQ60 System drawings, page 3
→ Wave propagation, page 5
→ Bottom echo, page 7
→ Observation range, page 9
→ Technical specifications, page 10

Important notice

Windows NT, Windows 2000, Windows XP and Windows are
either registered trademarks or trademarks of Microsoft
Corporation in the United States and/or other countries.

Echo sounder software version

This manual complies to echo sounder software version
1.5.0.74.
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System overview

Key facts
The Simrad EQ60 echo sounders is designed for the
professional fishery community implementing the latest
innovations.
• The EQ60 system is flexible and easy to configure due to the

modular design.
• Echo sounders ranging from relatively low-cost single beam

to large multi-frequency systems can be realised.
• Menus and dialogue boxes are operated by a standard mouse

or a roller ball.
• Large colour liquid crystal displays (LCD) are used. A

standard computer mouse may be used.
• The EQ60 uses the Microsoft Windows® display interface.

Operation is to a large extent self-explanatory. Getting started
is easy if you are familiar with standard Microsoft
Windows® programs.

• A store/replay function reduces the need for echogram
printout on paper. The unprocessed transducer signal is
recorded on the internal harddisk. During replay, this signal
is injected into the EQ60 processing software as if it arrived
directly from the transceiver.

Main units
The standard version of the EQ60 echo sounder consists of the
following units:
• a display unit with built-in echo sounder transceiver and

processor units
• a transducer
If required, the system can be expanded with additional
frequency channels by adding single beam General Purpose
Transceiver (GPT) units.
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Basic system diagram:

(A) = Echo sounder unit
(B) = Mouse
(C) = Keyboard (optional)
(D) = Junction box (only if required)
(E) = Transducer
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System diagram with
additional transceiver:

(A) = Echo sounder unit
(B) = Mouse
(C) = Keyboard (optional)
(D) = General Purpose Transceiver
(GPT)
(E) = Transducers
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Wave propagation

The velocity of sound wave propagation in the sea varies
slightly with temperature, salinity and pressure. The velocity
varies between 1440 and 1520 m/s in shallow sea water, while a
velocity around 1480 m/s can be expected at 1000 m depth. In
shallow fresh water the velocity is approximately 1430 m/s.

A good average value to be used in the Environment dialogue
box is 1470 m/s.

Figure 1 The
wave propagation
principles

The EQ60 transmits high energy sound wave pulses into the sea.
A flat bottom reflects the transmitted wave as if it were a mirror.
The propagating energy is spread over a larger and larger area as
it travels down to the bottom and up again. The energy is spread
over a four times larger area every time the travel distance
doubles.

A large school of fish reflects sound waves similarly. This type
of spreading is referred to as square-law or 20 log TVG (Time
Varying Gain) spreading.

The situation is slightly different when observing the echoes
from individual fish. The transmitted wave undergoes
square-law spreading when travelling from the surface and
down to the fish. The swim bladder of the fish scatters a small
fraction of the arriving energy in all directions. Travelling from
the fish and back towards the surface the scattered wave
undergoes another square-law spreading. The combined effect is
referred to as quad-law or 40 log TVG spreading.
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Propagation losses due to absorption are much higher in sea
water than in fresh water. Absorption also increases with
frequency. At 38 kHz the absorption is 0.5 dB/km in fresh water
and 10 dB/km in sea water. At 200 kHz the absorption is 10
dB/km in fresh water and 50 dB/km in salt water. The echo
sounder must know which water type is present in order to
compensate for these losses correctly.
(The dB (decibel) unit has long traditions in underwater
acoustics and other fields in physics. It is a logarithmic measure
for the ratio between two quantities).

Related topics

→ Environment, page 85
→ Echogram, page 81
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Bottom echo
A hard flat bottom reflects the transmitted signal as if it were a
mirror. The transmitted pulse hits the illuminated bottom area at
nearly the same instant, and the echo from different parts of this
area arrive back at the surface also at nearly the same instant.

Figure 2
Bottom echo

The received echo signal is basically an attenuated copy of the
short transmit pulse. The echo signal from a sloped bottom is
characterised by having a longer duration and a slower rise and
fall time. The transmitted pulse first hits the slope at point A,
and as time elapses the reflection point travels along the slope
towards point B. Many locations do not have a solid hard
bottom. Frequently, the bottom is composed of layers of mud,
clay and sand which can be observed as coloured bands on the
echo sounder display.
The bottom detection algorithm is implemented solely in
software, and separate algorithms are run for each frequency
channel. The algorithm is designed with emphasis on reliability
in the sense that erroneous depth detections are never output.
Whenever the quality of a detection is questionable the
algorithm outputs a depth of 0.00 to indicate that no reliable
detection was obtained. The EQ60 algorithm is designed to
handle a number of difficult situations. The algorithm maintains
bottom lock for a discontinuous jump in bottom depth. It avoids
false bottom detections on a dense school of fish. The algorithm
chooses the upper boundary of the first layer when the bottom
consists of layers.
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The bottom detection algorithm locks to the first good bottom
return. The depth at point A rather than the depth along the
transducer axis will be output for a sloped bottom. The detected
depth value is always smaller than the depth along the
transducer axis implying that a safety margin is automatically
included.
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Observation range
Absorption increases dramatically with frequency in salt water.
For maximum observation range you should select a low
operating frequency, a large transducer and the maximum
transmit power.

Figure 3 Observation range

Typical observation ranges are shown in the figure. Using the
Simrad 27-26/21 transducer (27 kHz, 10x13 degrees, 3000 W)
you can observe a 60 centimeter cod down to 800 meters, and
bottom detection works down to 3800 meters. However, with
the Simrad 200-7F transducer (200 kHz, 7x7 degrees, 1000 W)
you can only observe that same cod down to 260 meters, and
bottom detection becomes unreliable below 500 meters.
These range calculations assume a normal sea water salinity
(3.5%) and temperature (+10 degC), an average bottom (surface
backscattering strength = -20 dB) and a noise level typical for a
moving vessel.
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Technical specifications
The following is a summary of the technical specifications for
the EQ60 echo sounder. Note that the specifications may be
changed without prior warning.

Related topics

→ Echo sounder system, page 11
→ Interfaces, page 12
→ General Purpose Transceiver (GPT), page 13
→ PC Transceiver (PCT), page 14
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Echo sounder system
• Frequency channels: 1, 2, 3 or 4 channels
• Operating frequencies

- Basic configuration: 38/200 kHz or 50/200 kHz
- With additional GPT: 12, 18, 27, 38, 50, 70, 120, 200

kHz
• Echogram types

- Surface echogram
- Bottom expansion
- Trawl echogram

• Gain function
- 20 log TVG (= bottom gain)
- 20 log TVG (=school gain)
- 40 log TVG (= fish gain)

• Ping rate: Adjustable, maximum 10 pings per second
• Start depth and range: 5 to 15,000 meters in Manual, Auto

range or Auto start modes.
• Scope presentation: Displays the echo strength of the most

recent ping.
• Colour scale: 12 colours (3 dB pr colour)
• Bottom detector: Software tracking algorithm, adjustable

minimum and maximum depth
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External interfaces
Numerous external interfaces are provided for the EQ60 echo
sounder system.

Outputs

• Echogram printer (Centronics parallel)
• Bottom depth (NMEA)
• Depth data (NMEA, Simrad or Atlas)

Inputs

• Navigation receiver (NMEA)
• Motion sensor (Heave, roll and pitch)
• Analogue heave, roll and pitch (+/- 10 V)
• Annotation
• Transmit synchronization
• Temperature sensor

Remote control toggle switches

• Survey Line
• Remote power
• Transmit synchronization
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General Purpose Transceiver (GPT)
The General Purpose Transceiver (GPT) is an optional unit.
• Transmit power:

- Max 2 kW (Dual frequency GPT)
- Max 4 kW (Single frequency GPT)

• Receiver noise figure: 3 dB
• Transducer impedance: 60 ohms
• Output protection: Short circuit and open circuit protection
• Receiver input range: Instantaneous dynamic amplitude

range -160 dBW to -20 dBW (dB relative to 1W)
• Connectors

- Transducer: 12-pin female Amphenol, Shell
MS3102A-24, Insert 24-19S

- AUI: 15-pin female Delta
- Network: 8-pin RJ-45 socket
- Auxiliary: 25-pin female Delta

• Physical dimensions
- Width: 284 mm
- Height: 112 mm
- Depth: 246 mm

• Weights
- With one TX board: 2.7 kg
- With two TX boards: 3.3 kg
- With three TX boards: 4.5 kg

• Supply power and fuses
- AC: 95 to 265 Vac, 50-60 Hz, 50-100 W
- DC: 11 to 15 Vdc, 50-100 W

• Fuses
- AC fuse: Ø5x20 mm, 2 A slow
- DC fuse: Ø5x20 mm, 10 A slow or fast

• Operational temperature: 0 to +55 deg C

• Storage temperature: -40 to +70 deg C
• Humidity: 5 to 95% relative non-condensing
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Internal PC Transceiver (PCT)
• Transmit power: Max 1 kW RMS for each channel
• Transducer impedance: 60 ohms
• Output protection: Short circuit and open circuit protection
• Receiver noise figure: 4 dB
• Receiver input range: Instantanous dynamic amplitude

range -140 dBW to -20 dBW (dB relative to 1 W)
• Connectors

- Transducer: 9-pin female Delta
- Auxiliary: 25-pin female Delta

• Supply power: 95 to 265 Vac, 50-60 Hz, 50-100 W
(common with the display)
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DISPLAY VIEWS

Introduction
This chapter provides a brief overview of the information
displayed by the EQ60, and how it is organised.

Related topics

→ Display layout and main view, page 16
→ Menu bar, page 19
→ Header view, page 20
→ Echo frames, page 21
→ Status bar, page 23
→ History and printer views, page 24
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Display organisation

Main view

The EQ60 display is organised as follows (from top):

• Menu bar

• For each transceiver channel:

- One header view
- Two echo frames

• Status bar

A single channel display is shown below as an example.

(CD10203)

A B C DE

(A) Main menu (B) Header view
(C) Echogram and range view (D) Scope view
(E) Status bar
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Menu

The Menu bar contains the echo sounder’s main menu. A
single click on one of the menu names will provide a new
drop-down menu where additional choices can be made.

Header

For each channel, the Header view contains the current
operational mode and frequency, the current depth, and the
colour scale.

Echo frames

The Echo frame takes up the largest part of the echo sounder
window. Each Echo frame contains (from left) the Echogram
and Range view and the Scope view.

The Echo frame view is are also described in more detail in the
Getting started chapter.

Status bar

The Status bar presents the current event and line numbers,
current time, and other information provided by the echo
sounder.

Moving the boundary lines

You can modify the vertical size of the echograms by moving
the horizontal boundary line between the two echograms.

To do this:

1 Position the cursor at the boundary line.

2 Press the left mouse button.

3 Drag the cursor up or down vertically while keeping the
left mouse button pressed.

4 Release the left mouse button.

Using the same operation, you can modify other boundary lines
on the display;

• The horizontal line between the upper Echo frame and the
Header view

• The vertical line between the Echogram and Range view
and the Scope view
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Direct access to dialogue boxes
Several dialogue boxes are directly accessed from the various
views on the display.
Position the cursor, and right-click on the...
• Mode and frequency information in the Header view to

open the Transceiver Settings dialogue box.
• Depth value in the Header view to open the Bottom

Detector dialogue box.
• Colour scale in the Header view to open the Colour Scale

dialogue box.
• Range field in the Echogram and Range view to open one

of the Range dialogue boxes, depending of the current
echogram type.

• Echogram field in the Echogram and Range view to open
the Echogram dialogue box.

Related topics

→ Menu bar, page 19
→ Header view, page 20
→ Echo frames, page 21
→ Getting started; Operation, page 32
→ Status bar, page 23
→ Transceiver Settings, page 114
→ Bottom Detector, page 75
→ Colour Scale, page 78
→ Echogram, page 81
→ Surface Range, page 110
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Menu bar
The EQ60 Menu bar contains the Main menu.

(CD10204)

A B

(A) Main menu
(B) Menu bar
The main menu has the following options:
• File
• View
• Options
• Install
• Step!
• Help
To operate, click on the menu name and observe the drop-down
menu. Select a new item on the drop-down menu by clicking on
the command. Commands shown with light grey colour are
unavailable in the present configuration or operational mode.
The menus are all explained in the Reference Guide.

Related topics

→ Main menu, page 57
→ Reference guide, page 56
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Header view
The EQ60 Header view is shown directly above the two Echo
frames. The top Header view is thus located just below the
Menu bar. The Header view contains the following
information.
(A) Transceiver settings: Current mode and frequency
(B) Bottom detection: Current depth
(C) Colour Scale

(CD10205)
A B C

The Header view is a part of the channel. If more than one
channel is displayed, the Header view is duplicated as well.
The Header view provides direct access to the following
dialogue boxes:
• Right-click in the Transceiver settings field (on the Mode

and frequency information) to open the Transceiver
Settings dialogue box.

• Right-click in the Bottom detection field (on the Depth
value) to open the Bottom Detector dialogue box.

• Right-click on the Colour scale to open the Colour Scale
dialogue box.

Related topics

→ Transceiver Settings, page 114
→ Bottom Detector, page 75
→ Colour Scale, page 78
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Echo frames

Overview
The EQ60 Echo frames are the main information bearer on the
echo sounder display. The Echo frames are usually presented in
pairs with two echo frames for each channel.
The Echo frame contains the following views:
(A) Echogram and Range view
(B) Scope view

(C
D

10
20

7)

A B

Echogram and Range
The Echogram and Range view consists of an Echogram field
to the left and a Range field to the right. These are separated by
the vertical range axis. The Echogram field contains
information about the acoustical values, while the Range field is
used for specifying the range used in the Echogram field. The
settings in the Colour Scale is used to present the information.
When you place the cursor in the Echogram field, you can use
the mouse wheel to modify the gain setting, and hence the
display colour sensitivity. Each click of the wheel corresponds
to a 1 dB change. The same gain setting is available from the
Colour Scale dialogue box.
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Whenever the cursor is located within the Echogram field, a
small yellow label is visible. The label provides the following
information:
• Left: Depth at the cursor position
• Middle: Diameter coverage from the transducer beam
• Right: Current gain setting
To change the range, you can also use the mouse wheel. Place
the cursor inside the Range field to do this:
• In a surface related echogram you will modify the range,

while for a bottom related echogram, you will change the
start range.

• If you press the left mouse button while you use the mouse
wheel, the surface echogram will change its start value, while
the bottom related echogram will change its range.

Related topics
→ Getting started, page 33
→ Colour Scale, page 78

Scope
The Scope view is the rightmost view and shows a oscilloscope
view of the last ping corresponding to the settings in the
Echogram view.
This view draws a range of horizontal symmetrical colour lines.
The distance from the vertical centre axis and the line colour
reflects the received echo amplitude. A black horizontal line
across the view indicates the current bottom view.
If you press the right mouse button with the mouse pointer
positioned in the Scope view, the graphic presentation will be
replaced by a text based presentation of the data. The following
information is provided:
Channel:
Background Noise: yyy.y dBW
Receiver Amplitude: xxx.x dBW
Alongship angle: z.zz deg
Athwarthship Angle: z.zz deg
The background noise shown is the median of 20 equidistance
power samples in the total range of the current ping. The
receiver and the two angles (alongship and athwarthship) are
sampled at 100 m depth. During replay, you may find that this
depth setting is not availbale because the depth is less than 100
m. The receiver amplitude is then set to a minimum (235 dBW),
and the angles are set to zero.
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Status bar
The EQ60 Status bar is located at the bottom of the display. It
contains the following information:

(CD10209)

A B

C

D

E

G

F

(A) Information applicable for the current operation
(B) Event number
(C) Printer logo (when printer is active)
(D) Current temperature
(E) Storage line number
(F) Navigational information (latitude and longitude)
(G) Time
Note that the water temperature read-out will only be available
if a sensor is connected to the echo sounder. Also, navigational
information requires that the applicable position information is
connected to the echo sounder.

Related topics

→ Status bar, page 64
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History and printer views

Overview
The echogram information provided on the display will differ
slightly from the information provided on the printer and in the
History files. This is because the annotation settings differ
between the two media.
The annotations provided for display output are controlled by
the Annotations dialogue box. When enabled in the Prister
and History dialogue box, the annotations will also be sent to
the printer and to the History files.
The Printer and History dialogue box also enables additional
annotations to be printed.
The most important difference is that the annotations added to
the echogram will only show in full on the printer and in the
History dialogue box. To demonstrate this difference, refer to
the two illustrations.

Related topics

→ History, page 90
→ Annotations, page 70
→ Printer and History, page 100
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Display example

The first illustration shows an excerpt of the display view as it
appears during normal operation when several annotations have
been added.

The annotations are not displayed with all the information they
contain, they are merely added as vertical red lines.

Figure 4
Display
presentation

The next illustration shows how the History window presents
the same echogram.

Printer example

A printout from the echo sounder is shown below.

From the top left corner, you can see the following annotations.

(1) A depth annotation. This information will automatically
appear at regular intervals, and whenever you change the echo
sounder’s depth range.

(2) An external annotation with the text “This is an ATS
annotation”. This annotation has been imported on the serial line
from the navigation system.

(3) Two annotations with navigational information. This
information appears with regular intervals when enabled from
the Printer and History dialogue box.
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Figure 5 History and printer presentation
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(4) One Event annotation with both navigational and time
information added. This annotation is controlled by the
parameters in the Annotation dialogue box. It will only appear
on the printer output and in the History when you press the
Event number in the Status bar.

(5) One annotation with navigational information. This is
identical to item 3.

(6) One Text annotation with the text “Test in Horten”. This text
is entered in the Annotation dialogue box. You will need a
keyboard connected to your echo sounder to do this.

(7) Two annotations with navigational information. This is
identical to item 3.
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(8) One Event annotation with no additional information added.
The number shown (”0006”) is the event number. The
annotation appears on the printer output and in the History when
you press the Event number in the Status bar .
(9) One depth annotation. This is similar to item (1).
(Others) Several other annotations to provide examples.
To add Text, Time and Event annotation, you must open the
Annotation dialogue box. This box is accessed from the File
menu.
Additional text to the printer and History window is controlled
by the parameters in the Printer and History dialogue box. This
box is accessed from the File menu.
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GETTING STARTED

Introduction
This chapter will guide you through the main operations of the
EQ60 by the use of an operational example. The intention with
this chapter is to provide you with an overview of the main
functions in the echo sounder, and to demonstrate how the EQ60
may be used in a realistic operational situation.

Related topics

→ Before you start, page 29
→ Start-up, page 30
→ Operation, page 32
→ Data storage, page 36
→ Operational procedures, page 38
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Before you start
Before you start the EQ60, make sure that the necessary
hardware items are correctly installed and connected. The
transducer(s) must also be defined in the EQ60 software on the
computer.

Related topics

→ Physical installation of units, page 119.
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Start-up

Overview
This chapter provides the basic procedure required to power up
the echo sounder and start the pinging.

Power-up procedure
After these initial preparations you can open the EQ60 program
on the computer. The “power on” procedure is described in
detail in the Operational procedures chapter.

The menu system
The menu system is based on the Microsoft Windows®
commercial standard interface. An overall explanation of the
menu system with a description of the various views are
presented in the Display views chapter.

Transceiver inspection
First, we need to check that the transceiver (or transceivers) are
connected.
Open the Install menu, choose the Transceiver command to
open the Transceiver Installation Mode dialogue box. In this
dialogue, press the Inspect button to open the Transceiver
Settings dialogue box.
You may now check that the transceivers are installed correctly.
Active transceivers appear in green text in the Frequency
Channel Selection box.
Click the Cancel button to finish.
If none of the transceivers listed appear in green text, check the
connections and re-install the transceiver(s).

Environmental parameters
To obtain correct values for the various acoustical parameters
calculated by the EQ60 program, it is important that you provide
the EQ60 program with accurate parameters describing the
environment; sea temperature, salinity and sound velocity.
These values are defined in the Environment dialogue box.
Open the Install menu, choose the Environment command to
open the Environment dialogue box.
Unless the default values are acceptable, you must select Fresh
or Salt water, and enter the current sound velocity. This
information is used to calculate depth and absorption
coefficient.
Click OK when you have finished.
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Navigation interface
To link acoustical data with navigational data the EQ60 must be
able to receive data provided by a GPS or another positioning
system. The Navigation Interface dialogue box is used to
define the parameters to achieve this.
Open the Install menu, choose the Navigation command to
open the Navigation Interface dialogue box.
Specify how the EQ60 will receive navigational data. Since the
NMEA standard has been implemented, you only need to
choose between NMEA or ASCII.
Click OK when you have made the setting.

Additional interfaces
Additional interfaces have been provided for other peripheral
systems.
• If you need to link recorded acoustical data with trawl

position data, choose the Trawl command on the Install
menu to specify the trawl position interface.

• If you need to connect your EQ60 to a purse seine system,
choose the Purse seine command on the Install menu to
specify the purse seine system interface.

If you want to use a heave or a temperature sensor, choose the
Heave and Temperature commands on the Install menu to
specify these interfaces.

Related topics

→ Power on/off procedure, page 39
→ Display views, introduction, page 15
→ Frequency channels installation procedure, page 45
→ Transceiver Installation, page 112
→ Transceiver Settings, page 114
→ Environment, page 85
→ Navigation Interface, page 95
→ Heave Sensor, page 88
→ Temperature Sensor, page 111
→ Trawl Interface, page 116
→ Purse Seine, page 104
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Operation

Overview

This chapter describes a few of the most common functions used
during normal operation.

Selecting operational mode

You are now ready to start the actual operation of the EQ60
echo sounder. The first thing to do is to choose operational
mode.

Open the File menu, choose Operation to open the Operation
dialogue box. In the Mode group, click Normal for normal
mode.

(You may alternatively click Replay for replay mode, but you
must then also click Files to choose a replay file. Note that
operating in replay mode will restrict you from changing certain
parameters during operation.)

Next, you need to define the ping rate. To do this, locate the
Ping Rate group box, and set the ping rate to Interval for
manual setting of the ping interval. For this exercise, set the
ping interval time to 1 second, and click OK to finish.

The echo sounder will now start pinging, and after a few
moments the echogram field on the display will present a new
echo line. The various fields on the display are explained in
detail in the Display views chapter.

Transceiver settings

The operational mode and the transceiver frequency are
displayed to the far left in the Header view. A dedicated
dialogue box - Transceiver Settings - is used to define various
parameters associated with the transceiver. These settings
include transceiver mode, the depth of the transducer surface,
the transmit power, and the pulse length.

Note that if you operate in Replay mode, the transceiver settings
can not be changed.

Additional information about the transceiver settings are
available if you press the Advanced button in the Transceiver
Settings dialogue box.
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Bottom detector settings

The Header view on the display is also used to present the
current depth. The Bottom Detector dialogue box is used to
define various parameters associated with the bottom detection.
These include the depth range, where the EQ60 searches for the
bottom.

To open the Bottom Detector dialogue box, position the cursor
over the displayed depth in the Header view, and click the right
mouse button.

In our example we will assume that the depth will vary between
30 and 200 meters. Therefore, set Minimum Depth to 30 m and
Maximum Depth to 200 m. Click OK to accept the settings.

Note Setting both Minimum Depth and Maximum Depth to 0 m will
turn off bottom detection.

Colour scale
The Colour Scale field is used to display the colour scale for
mapping acoustical values. These colours are used in the
Echogram And Range view. Each colour always represents a
3 dB value range. Using all 12 colours in the colour scale thus
enables mapping of a 36 dB value range to colours.

Position the cursor over the colour scale, click the right mouse
button to open the Colour Scale dialogue box. Accept the
default settings and click OK.

Echogram and Range view
The Echogram and Range view consists of an Echogram field
to the left and a Range field to the right. These are separated by
the range axis. The Echogram field contains information about
the acoustical values, while the Range field is used for
specifying the range used in the Echogram field.

Echogram field

The Echogram field is used to display acoustical values for
each ping. The settings in the Colour Scale are used to
determine the colour sensitivity in the echogram.

Position the cursor in the Echogram field, and click the right
mouse button to open the Echogram dialogue box.
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The Echogram dialogue box allows you to define the area of
interest for the echogram. Your choice will affect the meaning
and the options in the Range field in the Echogram view. You
can also choose the TVG function used to calculate the
acoustical values.
In this example, choose Surface – Manual to enable a surface
related echogram. Then, choose the School gain TVG function
for calculating sV-values. Finally, click OK to accept the
settings.

Range field

The Range field allows you to read and specify the range used
in the Echogram field. The current range is displayed on the
range axis. In the Range dialogue box you can define the area of
interest for the echogram.
Position the cursor in the Range field, click the right mouse
button. Observe a dialogue box referring to either Surface,
Bottom, or Trawl depending on your choice in the Echogram
dialogue box.
In this case, check that you have the Surface Range dialogue
open.
Set Range to 200 m and Start Relative Surface to 0 m, then
click OK to accept the settings.

Comments to the Echogram and Range view

Two echograms are shown for each Channel. The second
echogram for the present Channel may be used in the current
example to show the distribution of fish close to the bottom.
• Use the Echogram dialogue in the second Echogram view

to set the Echogram to Bottom and choose the School gain
TVG function for calculating SV-values.

• Use the corresponding Bottom Range dialogue to set Range
to 20 m and Stop Relative Bottom to 5 m for the echogram
to show values calculated from 15 m above the detected
bottom to 5 m below the bottom.

When you place the cursor in the Echogram field, you can use
the mouse wheel to modify the receiver gain level, and hence
the display colour sensitivity. Each click of the wheel
corresponds to a 1 dB change. The same colour sensitivity
setting is available from the Color Scale dialogue box.
Whenever the cursor is located within the Echogram field, a
small yellow label is visible. The label provides the following
information:
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• Left: Depth at the cursor position

• Middle: Diameter coverage at the transducer beam at the
current cursor position

• Right: Current gain setting

To change the range, you can also use the mouse wheel. Place
the cursor inside the Range field to do this:
• In a surface related echogram you will modify the range,

while for a bottom related echogram, you will change the
start range.

• If you press the left mouse button while using the mouse
wheel, the surface echogram will change its start value, while
the bottom related echogram will change its range.

Scope view
The Scope view is the rightmost view and shows a scope view
of the last ping corresponding to the settings in the Echogram
view.
This view draws a range of horizontal symmetrical colour lines.
The distance from the vertical center axis and the line colour
reflects the received echo amplitude. A black horizontal line
across the view indicates the current bottom view.

Related topics

→ Display views, introduction, page 15
→ Transceiver Settings, page 114
→ Advanced Transceiver, page 68
→ Bottom Detector, page 75
→ Colour Scale, page 78
→ Echogram, page 81
→ Surface Range, page 110
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Data storage

Overview
This chapter presents a brief description of the data storage
functionality.
Note that you can not perform all the operations described here
if your echo sounder does not have a keyboard.

Define storage parameters
It will often be beneficial to store some of the echo information
recorded during an operation. This allows you to change certain
parameter settings when operating in replay mode at a later
time.
Open the File menu, choose Store to open the Store dialogue
box.
Note that Store is not available when operating in Replay mode.
The Store dialogue box allows you to set various parameters
associated with data storage. You can define a specific directory,
and limit the file sizes.
Click Browse in the Survey box. Browse to the desired
directory for file storage, or enter the directory name directly
into the text box. If the directory does not exists it will be
created.
Click the Save Raw Data check box to save raw data. Define
maximum file sizes by entering the desired value in the Max
File Size box, and click OK to accept the settings.
When Save Raw Data is checked, the raw unprocessed
transceiver data containing amplitude and angle information for
the split beam transducers will be recorded.

Start and stop data storage
To start and stop data storing, use the Line field in the Status
bar. The Line field is marked LXXXX and shows the current
survey line number.
Position the cursor over the Line field in the Status bar and
click the left mouse button. Observe that the survey line number
increments, and that the line colour changes from black to red.
To stop data recording click the Line field again.
The red colour indicates that data recording is active. When the
recording stops, the colour is changed back to black. The file
names used for the stored data are determined by the survey line
number and the date and time when recording started. A new
file is created for each new survey line number.
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Related topics

→ Store, page 108.
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OPERATIONAL PROCEDURES

Overview
This chapter contains a number of specific procedures to be
used with your EQ60 echo sounder.

Related topics

→ Power on/off, page 39
→ Basic operations, page 41
→ Transceiver installation, page 45
→ Record and playback, page 47
→ Software installation and upgrade, page 52
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Power on/off
Use the following procedures to switch the EQ60 echo sounder
on and off.

Power on
It is assumed that the echo sounder’s hardware and software are
properly installed and configured.
1 Switch power on.
2 Observe the hardware test messages and operating system

start-up messages.
- It takes a couple of minutes before the echo sounder

window appears on the display.
The echo sounder memorises all its settings when power is
switched off. Hence, pinging will start immediately if the echo
sounder was pinging when you switched power off.
If pinging does not start you must check the settings in the
following dialogue boxes:
• Operation

• Layout

• Transceiver Settings

• Transceiver Installation

If you are not successful you should use this procedure:
1 Check the Transceiver Installation dialogue box.
2 All frequency channels must be properly installed.
3 Select Factory settings in the Options menu.

Power off
To switch off the EQ60 echo sounder, observe the following
procedure.
1 Select Shutdown on the File menu.
2 Allow the computer to close all the echo sounder software

applications.
3 Switch off power.
4 Switch off the power on the General Purpose Transceiver

and other peripherals (if any).

Related topics

→ Operation, page 97
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→ Layout, page 94
→ Transceiver Settings, page 114
→ Transceiver Installation, page 112
→ Options menu, page 60
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Basic operations

Overview
This chapter presents a number of common procedures
frequently carried out on the EQ60 echo sounder.

Changing the echogram settings
To change the echogram settings:
1 Position the cursor in the Echogram field.
2 Click the right mouse button.
3 Observe the Echogram dialogue box.
4 Make the required changes.

Related topics

→ Echogram, page 81

Changing the range
To change the range:
1 Position the cursor in the Range field.
2 Click the right mouse button.
3 Observe the Bottom Range or Surface Range dialogue

box.
4 Make the required changes
or:
1 Place the cursor in the Range field.
2 Use the mouse wheel to change the range.

Related topics

→ Bottom Range, page 77
→ Surface Range, page 110

Changing the vertical resolution
The vertical resolution of the echogram increases with a shorter
pulse length.
For example, a pulse length of 1.024 millisecond gives a vertical
resolution of 19.2 cm, whereas a pulse length of 0.256
millisecond gives a vertical resolution of 4.8 cm. If the vertical
distance between two echoes is less than this, the two echoes
will be shown as one
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To change the pulse length:
1 Position the cursor over the frequency information in the

Header view, and click the right mouse button.
- The Transceiver Settings dialogue box opens.

2 Move the pulse length slider to the desired pulse length
value.

3 Click Ok.
A small value gives the best resolution, while larger values are
mostly used for navigation and fishing in deep waters.

Related topics

→ Header view, page 20
→ Transceiver Settings, page 114

Changing the transmit power
To change the transmit power:
1 Position the cursor over the frequency information in the

Header view, and click the right mouse button.
- The Transceiver Settings dialogue box opens.

2 Move the transmit power slider to the desired value.
3 Click Ok.

Related topics

→ Header view, page 20
→ Transceiver Settings, page 114

Setting minimum and maximum depth
Setting the minimum and maximum depth controls where the
echo sounder will search for bottom lock.

Note Setting both Minimum Depth and Maximum Depth to 0 m will
turn off bottom detection.

1 Position the cursor over the depth information in the
Header view, and click the right mouse button.
- The Bottom detector dialogue box opens.

2 Set minimum and maximum depth to the desired values.
3 Click Ok.
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Related topics

→ Header view, page 20
→ Bottom Detector, page 75

Enabling the depth alarms
You can set individual alarms for minimum and maximum
depth. You can also enable an alarm to sound off if the bottom
track is lost.
1 Position the cursor over the depth field in the Header

view, and click the right mouse button.
- The Bottom detector dialogue box opens.

2 Set the values for minimum and maximum depth alarm.
3 Enable the alarms by ticking the appropriate boxes.
4 Enable the Bottom Lost Warning if required.
5 Click Ok.

Related topics

→ Header view, page 20
→ Bottom Detector, page 75

Adding annotations
You can add several different annotations to the displayed and
printed information. All annotations are automatically
displayed, while you need to enable the annotations to be
printed.

Enable annotations to be printed

1 Select Print on the File menu.
- The Printer and History dialogue box opens.

2 Under Text to printer, click Annotation.
3 Click OK to exit.
The annotations will be printed until this procedure is repeated.

Enter annotations

Three different annotations may be controlled from the
Annotations dialogue box.
1 Select Annotation on the File menu.

- The Annotation dialogue box opens.
2 To enter a single text annotation to the display:



Simrad EQ60

44 857-164342 / Rev.C

a Enter the desired annotation text into the Text box. A
keyboard must be connected to the echo sounder to
allow this.

b Click OK.
c The text you entered is displayed immediately, but it

will not be repeated.
3 To add the current time as an annotation:

a Under Time, click Active.
b Enter the desired interval (in seconds) between the

annotations.
c Click OK.
d The annotation will be repeated at the chosen interval

until it is switched off.
4 To add an event annotation:

a Under Event, select a start number.
b Click Increase or Decrease to count the Event number

up or down.
c Click Add Time if you wish the event annotation to

include the current time.
d Click Add Navigation if you wish the event annotation

to include the current position.
e Click the Event button on the Status bar every time

you wish the annotation to be added to the display
and/or print.

Enable external annotations

The echo sounder will accept external text annotations when
these are input on the serial line. This function is permanently
enabled.

Related topics

→ Annotation, page 70
→ Printer and History, page 100
→ Annotation format, page 71
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Transceiver installation

Overview
Use the following procedures to install, modify or delete
frequency channels from the echo sounder set-up.
The ISA bus in the built-in transceiver is searched for available
channels, and these are displayed in a list.
General Purpose Transceivers (GPT) physically connected to the
echo sounder’s ethernet interface are identified automatically by
the system. When you open the Transceiver Installation
dialogue box from the Install menu, a list will be provided.
A single frequency transceiver occupies one entry in the list, and
a dual frequency transceiver occupies two. Each entry is
identified as a frequency channel, and the line displays the
parameters for the channel. Entries in the frequency channel list
are shown in black, green or red colour identifying its current
status.

To install a channel
1 Select Transceiver on the Install menu.
2 Select Modify in the Transceiver Installation Mode

dialogue box.
- The Transceiver Installation dialogue box opens, and

you are allowed to make changes.
3 Click the desired entry (one of the black colour line

alternatives) in the Frequency Channel Selection list.
4 Assign a transducer by selecting a transducer name in the

Transducer Selection list.
5 Click OK to accept the choice and exit the dialogue box.
6 Restart the echo sounder as described below.

Related topics

→ Transceiver Installation, page 112

To uninstall a channel
1 Select Transceiver on the Install menu.
2 Select Modify in the Transceiver Installation Mode

dialogue box.
- The Transceiver Installation dialogue box opens, and

you are allowed to make changes.
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3 Click the desired entry in the Frequency Channel
Selection list.

4 Select the alternative NONE in the Transducer Selection
list.

5 Click OK to accept the choice and exit the dialogue box.
6 Restart the echo sounder as described below.

Related topics
→ Transceiver Installation, page 112

To modify an IP address
This procedure allows you to modify the IP address of the
currently selected General Purpose Transceiver (GPT).
1 Select Transceiver on the Install menu.
2 Select Modify in the Transceiver Installation Mode

dialogue box.
- The Transceiver Installation dialogue box opens, and

you are allowed to make changes.
3 Select the General Purpose Transceiver (GPT) you wish to

modify.
4 Click the Set New GPT IP Address button.

- The IP Address dialogue box opens.
5 Enter the new IP address.

- The significance of the address numbers is described
with the IP Address dialogue box.

6 Click OK to accept the choice and exit the dialogue box.
7 Click OK to exit the Transceiver Installation dialogue

box.
8 Restart the echo sounder as described below.

Related topics
→ Transceiver Installation, page 112
→ IP Address, page 91

Restart the echo sounder
Whenever a change has been made to any of the frequency
channels, you must restart the echo sounder.
1 Select Operation on the File menu.

- The Operation dialogue box opens.
2 Select Normal operation, and click OK.

Related topics
→ Operation, page 97
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Record and playback

Overview
You can set up the echo sounder to record the unprocessed
transducer signals on the internal harddisk or other recordable
media. This recorded signal may later be injected into the echo
sounder’s processing software as if it arrived directly from the
transceiver.
During this replay, you may experiment with some of the echo
sounder settings.
This feature is useful during training and demonstration. It is
also useful for memorising a particularly interesting observation
at the fishing grounds.
You can also use the built-in History function to record
echogram data.

Record

Preparations

The recording is prepared as follows.
1 Select Store on the File menu.

- Observe the Store dialogue box appear.
2 Select the complete path of the survey directory.

- The directory is selected when you click the OK
button. Click the Browse button if you wish to navigate
through the disk directories. A new directory is created
if the requested does not exist.

3 Select if you wish to save raw and/or output data.
- Raw data: The unprocessed transceiver data are stored

in standard computer files. These files contain all the
necessary data for reconstruction of the situation during
the real survey. Thus the data include amplitude, phase,
navigation data, annotation input etc. The echo sounder
program reads these files during replay.

- Output data: This is the processed output data;
navigational data, bottom detections, annotations etc

4 Select the initial line number.
5 Enter the maximum size of each replay file.
6 Click Ok.

Start recording

Use the Line field in the Status bar to start the recording.



Simrad EQ60

48 857-164342 / Rev.C

1 Position the cursor over the Line field.
2 Press the left mouse button.
The line number increments, and the Line field is presented
with a red colour.

Stop recording
To stop the recording:
1 Click the Line field once again.

- The original colour is restored.

Size of stored raw data
The total size of raw data files stored on disk during operation
depends on several user selections. From these selections you
may estimate approximately the total amount of raw data stored
in a given time period for each installed channel using the
following equation:
X = (B bytes per sample) S ((8 S R) / (c S tau samples per ping))
S (M ping per sec) S 24 S (3600 sec per day) S (K days)
Where:
X = Total amount of stored raw data in bytes for one channel
B = 4 (Given by the echo sounder)
R = Maximum range in meters (User set)
c = Sound speed in water in meters per sec (User set)
tau = Pulse duration in seconds (User set)
M = Ping rate in ping per seconds (User set)
K = Number of operating/storage days (User set)
Thus, you can affect the amount of stored raw data by changing
e.g. the range, pulse duration, and ping rate settings.
Example:
With range = 10 m, pulse length = 256 µS, 15 pings per second
and sound velocity = 1500 m/s, the storage requirement will be
45 Mb per hour. If you increase the range to 80 m, and reduce
the ping rate to 7 pings per second, the storage requirement will
be 60 Mb per hour.

Related topics
→ Store, page 108
→ Status bar and Line field, page 64

Playback
When replaying the recorded signal, the ping rate is not limited
by the speed of sound in water. Hence, a higher ping rate is
possible during replay than during normal operation.
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The playback is started as follows:
1 Select Operation on the File menu.

- Observe the Operation dialogue box appear.
2 Click Replay.
3 Click Files...

- Observe the Replay dialogue box appear.
4 Select survey with the standard file selection dialogue.
5 Click on the file(s) you wish to replay.

- Observe that the currently selected file(s) appear in the
Selected files list box.

6 Click Loop if you wish the replay to loop through the
selected file(s) endlessly.

7 Click Save Output Data if you wish to record the file(s)
in processed format during playback.
- The files are stored with the same name and in the

same location as the raw data files, but with the file
extension *.OUT

8 Click OK to return to the Operation dialogue box.
9 In the Operation dialogue box, click OK to start the

playback.
If you do not select Loop, the replay is stopped when the last
recorded ping has been processed.

Related topics

→ Operation, page 97.
→ Replay, page 105.

History
The History function is used to store echograms on bitmap
format. The echo sounder may continuously save echogram
pictures to the internal harddisk or an other recordable media.
These can later be recalled on the display. The information in
the History window is the same as on the printer.
The horizontal width of each echogram picture roughly
corresponds to the the half width of the display. The number of
history files is limited. After reaching the maximum number of
files, the newest echogram picture overwrites the oldest one.
The history function allows you to quickly look through
echogram pictures covering several hours.

Record

To start History recording:
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1 Select Operation on the File menu.
- Observe the Operation dialogue box appear.

2 Click Save in the History field.
3 Click Browse to select disk directory.
4 Click Ok to start the recording.
To stop History recording:
1 Select Operation on the File menu.

- Observe the Operation dialogue box appear.
2 De-select Save.
3 Click Ok.

Playback

To view the information recorded by the History function:
1 Select History on the View menu.
2 Browse the information in the History dialogue box.
The information provided by the History view is presented in a
separate window. The echo sounder will operate normally in the
background. However, you will not have access to any of the
menues as long as the History window is open. When you wish
to focus on the echo sounder operation, close or minimize the
History window.

Print the current History information

To print the current view in the History window:
1 Select History on the View menu.
2 Press the printer symbol in the bottom right corner to print

a single history file.
- Note that only the file presented on the display is

printed.

(C
D

56
39

A)

A

B
(A) Press to print current view
( B) Press to print multiple views
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Print multiple History files

To print several images recorded by the History function,
follow this procedure.
Note that a keyboard is required.
1 Select History on the View menu.
2 Browse the information in the History dialogue box until

you find the images you wish to print.
3 Press the left printer icon (with the + sign) in the lower

right corner of the History window.
4 Press the Ctrl key on the keyboard and the left mouse

button simultanously to select the images to be printed.

5 Press the right mouse button, observe the shortcut menu.
6 On the shortcut menu, select Print.

7 Press Cancel to close the dialogue box.

Related topics

→ History window, page 24
→ History, page 90
→ Status bar; page 64
→ Operation; page 97
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Software installation and upgrades

Overview
The echo sounder is initially delivered with all necessary
software installed and configured. Software upgrades are useful
if your echo sounder fails, and you suspect a software error. An
upgrade is also required whenever the echo sounder software is
modified.
The computer should automatically detect the insertion of the
CD-ROM and open the Installation program dialogue box. If
this is not the case, you must manually run the Setup.exe
program on the CD-ROM’s root directory.
When the echo sounder software is upgraded, the software will
automatically detect the presence of General Purpose
Transceiver(s), but you will need to check that the correct
transducer(s) are enabled.
Whenever new echo sounder software is installed, you will need
to define all serial lines, transducer(s) and transceiver(s).

Related topics

→ Transceiver installation procedure, page 45.

Software installation procedure
Use this procedure if you need to install the software on a new
computer. Note that minimum hardware and software
requirements must be met by the computer.
1 Connect a keyboard to the echo sounder., or start the

On-screen keyboard application (normally located under
Accessories and Accessibility).

2 Connect a CD ROM unit to the parallel port.
3 Switch on the echo sounder.
4 Insert the software CD.
5 Observe the Installation program dialogue box open.
6 Enter the correct values for I/O, DMA and IRQ. These

values are given on the CD cover.
7 Press Complete installation.
8 Allow the echo sounder installation to run. Follow the

instructions provided.
9 When requested, enter the license number.

- This number is located on the CD cover. This number
is unique for each individual echo sounder.
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10 Click OK when prompted to reboot the system.

Software upgrade procedure
Use this procedure if you wish to reinstall the software, or
receive a new CD-ROM with a software upgrade.
1 Connect a keyboard to the echo sounder., or start the

On-screen keyboard application (normally located under
Accessories and Accessibility).

2 Connect a CD ROM unit to the parallel port.
3 Switch on the echo sounder.
4 Insert the software CD.
5 Observe the Installation program dialogue box open.
6 Press Update installation.
7 Allow the echo sounder installation to run. Follow the

instructions provided.
8 When requested, enter the license number.

- This number is located on the CD cover. This number
is unique for each individual echo sounder.

Un-installation procedure
Use this procedure if you need to remove all the echo sounder
software from the computer. Note that all data in the EQ60
directory will be erased.
1 Power up the computer.
2 Insert the EQ60 CD-ROM.
3 Observe the Installation program dialogue box open.
4 Press Uninstall.
5 Allow the echo sounder un-installation program to run.

Follow the instructions provided.

Software on a third party computer
The EQ60 may operate with a locally purchased computer,
provided that this computer meets the minuimum requirements
defined by Simrad. If in doubt, consult your dealer.
To install the software and operate the echo sounder from a third
party computer, you will need to set up the computer correctly,
and you will need a separate licence number.

How to set up the computer
This procedure assumes that you are familiar to the operating
system. DO NOT attempt to set up the computer if you are
unfamiliar with the settings described here, but consult your
dealer.
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1 Open the Control Panel to access the Network
connections.

2 Open the Local area connection.

3 Press Properties.
- Observe the Local Area Connection Properties

dialogue box appear.

4 Select the General tab, and click on Internet Protocol
(TCP/IP)

5 Press Properties.
- Observe the Internet Protocol (TCP/IP) Properties

dialogue box appear.

6 Click Use the following IP address, and enter the
following IP address: 157.237.14.12
- The Subnet mask will automatically be set to

255.255.0.0.

7 Click OK to accept the choice and to close the Internet
Protocol (TCP/IP) Properties dialogue box.

8 Click OK in the remaining dialogue boxes until all are
closed.

9 Restart the computer.

How to obtain a licence number

Each individual computer used to run EQ60 software will
require a dedicated licence code. When a third party computer is
used, this code must be obtained from the manufacturer.

Observe the following procedure:

1 Observe the My computer icon on the computer desktop.

2 Right-click once on the icon, then left-click to open the
short-cut menu.

3 Select Properties.

4 Select the General tab.

5 Observe the information provided under Registered to:

6 Write down the number provided

7 Press Cancel to close the dialogue box.

8 Send the registration number and the serial number on
your GPT(s) to your local dealer to obtain a licence code.
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Note It is very important that the computer’s registration number is
recorded correctly. Make sure that there are no misprints or
misunderstandings. The licence code is generated from the
registration number, and with even a single digit wrong the code
will not work.
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REFERENCE GUIDE

Overview
This chapter describes the menus and dialogue boxes in detail.

Related topics

→ Echo sounder menus, page 57
→ Dialogue boxes, page 65
→ Status bar, page 64
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Menus

Main menu
The Main menu contains the following options:
→ File, page 58
→ View, page 59
→ Options, page 60
→ Install, page 62
→ Step, described below.
→ Help, page 63
Note that a number of dialogue boxes are accessed directly
using right-click on certain display fields.

Step!

In single-step mode you command the echo sounder to perform
one ping at a time by left-clicking the Step command. This
command does not activate any separate menus or dialogue
boxes.
See the Operation dialogue box for further details.

Related topics

→ Direct access to dialogue boxes, page 18
→ Operation, page 97
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File menu
The following commands are available on the File menu:
→ Operation, page 97
→ Store, page 108
→ Annotation, page 70
→ Print, page 100
→ Shutdown, page 86.

Operation

This command option opens the Operation dialogue box. Use
these parameters to set echo sounder ping mode parameters;
normal/replay, ping interval etc.

Store

This command option opens the Store dialogue box. Use this
dialogue box to record data.

Annotation

This option opens the Annotation dialogue box. In this dialogue
box you can enter an annotation text message to be printed on
the echogram and/or saved to the current file.

Print

This command option opens the Printer and History dialogue
box. Use it to set printer parameters controlling echogram
printout on paper.

Shutdown

Select this command to terminate the echo sounder program.

Note You must always use this command before you turn off power!
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View menu
The View menu contains the following options:
→ Layout, page 94
→ History, page 90

Layout

This command opens the Layout dialogue box. Use it to modify
the layout of frequency channels on the display.

History

This command opens the History dialogue box. This is used to
activate a dialogue for viewing previously recorded echograms.
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Options menu
The following commands are available on the Options menu:
→ Language, page 93
→ Depth unit, see below
→ Temperature unit, see below
→ Palette, see below
→ Beeper, see below
→ Save settings, see below
→ Restore settings, see below
→ Factory Settings, page 87

Language

This entry opens the Language dialogue box for language
selection.

Depth unit

All depth values are expressed in meters, English feet (1 ft =
0.3048 m), nautical fathoms (1 ftm = 1.852 m) or Italian Passi
Braccia (1 pb = 1.65 m). The Depth Unit entry activates a
submenu to select one of these alternatives.

Temperature unit

Water temperature is shown in degrees Celsius or degrees
Fahrenheit on the Status Bar. The Temperature Unit entry
activates a submenu to select one of the two alternatives.

Palette

Different light intensities on the display are provided according
to IMO (International Maritime Organisation)
recommendations. A bright display is required on a sunny
summer day, and a low light intensity is required at night in
order not to ruin the night vision of the crew at the bridge of the
vessel. The Palette entry activates a submenu to select the
display brightness.

Beeper

This entry activates a submenu to control when the audible
warning signal is active to alert about status messages and
alarms. No dialogues are provided.

Save settings

The echo sounder memorises all its parameter settings between
power is turned off until it is turned on again at a later time. The
Save Settings entry writes a snapshot of all parameter settings
into static memory. No dialogues are provided.
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Restore settings

This entry reads parameter settings from static memory into the
echo sounder application. No dialogues are provided.

Factory settings

This entry copies the default factory settings back into the
sounder. A proper clean-up of the complete menu system is
sometimes required in order to escape from unintentional
deadlocks. A dedicated dialogue box is used to acknowledge the
function.
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Install menu
The following commands are available on the Install menu:
→ Transceiver, page 112
→ Environment, page 85
→ Navigation, page 95
→ Trawl, page 116
→ Purse Seine, page 104
→ Heave, page 88
→ Temperature, page 111
→ BI500, page 73

Transceiver

This command opens the Transceiver Installation dialogue box.
Use this to install a new transceiver, and to assign a transducer
to each frequency channel.

Environment

Select this command to open the Environment dialogue box.
The settings here are used to select salt or fresh water
absorption, and to enter the sound velocity value.

Navigation

This command opens the Navigation Interface dialogue box. In
this box, you can select communication parameters for the
NMEA interface, and select input/output telegrams.

Trawl

This command option opens the Trawl Interface dialogue box.
Use these parameters to select trawl instrumentation
communication parameters; input/output telegrams.

Purse seine

This command option opens the Purse Seine dialogue box. Use
these parameters to select trawl instrumentation communication
parameters; input/output telegrams.

Heave

This command opens the Heave Sensor dialogue box. It is used
to select heave input source; analogue or RS-232.

Temperature

This command option opens the Temperature Sensor dialogue
box.

BI500

This command option opens the BI500 dialogue box.
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Help menu
The Help menu contains the following options:
• Contents
• About the echo sounder

Contents

This command opens the on-line user manual. This user manual
is an HTML based document compiled to the CHM format
designed by Microsoftt.
The content of the on-line user manual is identical to the first
chapters in the printed manual.
The on-line manual is also accessed directly as context sensitive
help from the various dialogue boxes used throughout the echo
sounder software.

About the echo sounder

This command opens the About box. This box is for
information only. It provides the current software version and
the copyright information.
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Status Bar
The Status Bar at the bottom of the screen displays status
messages, event number, printer active symbol, water
temperature, navigational data (latitude and longitude) and time
of day.

(CD10209)
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C

D
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F
The following information is provided on the Status bar:
(A) Information - Various messages are displayed in this field;
warnings, status, information text.
(B) Event - This field implements a push button for generating
an annotation of the “event” type. The event number is
automatically incremented or decremented by one for each new
event. The current event number is displayed.
(C) Printer - A printer symbol is displayed whenever echogram
printing is active. Printing is delayed until the echogram page
has been completed.
(D) Temperature - Water temperature is displayed in degrees
Celsius or in degrees Fahrenheit provided a temperature sensor
is connected to the system.
(E) Storage line number - This field acts as a toggle button. A
left-click starts a recording, and another left-click terminates the
recording. The line number is automatically incremented by one
every time you start the recording. The current line number is
displayed on the button facea, and it is shown with red colour
during recording. The recording is controlled by the Store
dialogue box.
(F) Navigational data - Geographical latitude and longitude
from the navigation receiver is displayed.
(G) Time - Local time of day is displayed. A small popup
window showing the current date appears when positioning the
cursor inside the time field. During replay, this field is used as a
timer.

Related topics
→ Recording procedure, page 47
→ Store, page 108
→ Print and History, pages 100
→ Print Setup, page 102
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Dialogue boxes

Introduction
The following chapters describe in detail all the dialogue boxes used in the EQ60 echo
sounder. The dialogue boxes are presented in alphabetical order.

→ Advanced Navigation, page 66
→ Advanced Transceiver, page 68
→ Annotation, page 70
→ BI500, page 73
→ Bottom Detector, page 75
→ Bottom Range, page 77
→ Colour Scale, page 78
→ Depth Output, page 80
→ Echogram, page 81
→ Environment, page 85
→ Exit, page 86
→ Factory Settings, page 87
→ Heave Sensor, page 88
→ History, page 90
→ IP Address, page 91
→ Language, page 93
→ Layout, page 94
→ Navigation Interface, page 95
→ Operation, page 97
→ Printer and History, page 100
→ Print Setup, page 102

→ Purse Seine, page 104
→ Replay, page 105
→ RS-232 Setup, page 107
→ Store, page 108
→ Surface Range, page 110
→ Temperature Sensor, page 111
→ Transceiver Installation, page 112
→ Transceiver Settings, page 114
→ Trawl Interface, page 116
→ Trawl Range, page 118
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Advanced Navigation
The Advanced Navigation dialogue box is accessed from the
Navigatiuon Interface dialogue box. The Navigation Interface
dialogue box is in turn available from the Install menu.

NMEA Sentence

These boxes specify which type of NMEA navigation sentence
should be automatically interpreted.
All means that any GLL, GGA and GXA sentences are
interpreted.

ASCII Setup

Use this protocol if you wish to receive data on ASCII format.
Decoding is based on a user specified datagram identification.
The information substring within the datagram may be
identified by specifying the position of the start field, the
number of fields to be extracted and the field separator.
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No. of fields - Identify the total number of fields in the ASCII
message.
Start field - Identify which of the fields in the message is the
start field.
Field separator - Identify which ASCII character is used to
separate the fields in the message.
Terminator - Identify which character is used to terminate the
message.

Related topics

→ Navigation Interface, page 95
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Advanced Transceiver

This dialogue box is accessed from the Transceiver Settings
dialogue box. It displays detailed numeric information
characterising the channel. This includes transducer parameters,
exact transmit frequency and receiver processing parameters.

Parameters

The parameters shown in this dialogue box are determined
during the transceiver installation procedure.

The descriptions are included for information only. You do not
need to understand these parameters to operate the echo sounder.

Frequency [Hz] - This is the nominal resonant frequency for
the transducer.

Beam type - Three different transducer beam types are
available: Single, Split and Triple. If your system is capable of
operating a Split- or Triple beam transducer, it will also be able
to measure the position of a target in the beam. The echo
sounder can then compensate for the known beam pattern to
obtain a true target strength.

Gain [dB] - The transducer gain presented by calculating the
directivity multiplied with the transducer’s efficiency. The value
is obtained during system calibration. If no calibration takes
place, the manufacturer’s default setting is used.

Two-way beam angle [dB] - This is a key transducer
parameter. The value describes the solid angle at the apex of the
ideal conical beam.

Sa Correction [dB] - This parameter is determined during the
calibration process. The value represents the correction required
to the Sv constant to harmonize the TS and sA measurements.
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Absorption [dB/km] - This value describes the absorption of
sound in the water. The default values are computed according
to Francois and Garrison, Journal of Acoustic Society,
December 1982. The most important environmental variable
affecting this parameter is found in the Environment dialogue
box.
Bandwidth [Hz] - This is the resulting system bandwidth of the
analogue and digital filters in the echo sounder receiver. The
bandwidth is a function of the selected pulselength at a given
frequency.
Sound velocity [m/s] - The speed of the sound through the
water varies with temperature, salinity and pressure. The
soundings provided by the EQ60 are compensated for this.
Sample interval [m] - This value is always 1/4 of the current
pulse length. In distance, the sample interval will be expressed
as (sound velocity multiplied with pulse length) divided by
eight.
Angle sensitivity - In order to convert the raw angle samples
into mechanical degrees for fore-and-aft and athwartship
directions, this parameter is required. It represents the ratio of
electrical degrees to mechanical degrees for the current
transducer. This ratio is not used with single beam transducers,
and the value is set to 0.
3dB beam width [degrees] - This value presents the 3 dB
beamwidth of the current transducer in the fore-and-aft and
athwartship directions. The value is estimated during
calibration. If no calibration takes place, the default value is
used.
Angle offset [degrees] - This is the offset angle from the
acoustical axis. The value is estimated during calibration. If no
calibration takes place, the value 0 is used.

Related topics

→ Transceiver Settings, page 114.
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Annotation

The Annotation dialogue box is opened from the File menu.

The EQ60 echo sounder supports these different types of
annotation:

• Text - use this function to enter your own text.

• Time - use this annotation to automatically generate a time
marker at specified intervals.

• Event - use this annotation to generate an event number with
optional addition of time and/or navigation.

• External - this function allows automatic annotation from an
external source.

Note that the Text annotation is only available if you have a
keyboard connected to the echo sounder.

An annotation telegram is written into the replay data file and
the output data file. The annotation message is only shown
inside the history window and on the echogram printout.
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Text

The annotation text is entered here. Note that you need to have a
keyboard connected to the echo sounder. The text can be entered
freely, for example ”Dangerous wreck”. When you press the
OK button the text is written into the echogram. The next time
you open the Annotation dialogue box, the text is cleared, and
you must enter new information.

Time

Click Active to activate automatic time annotation. Enter the
desired time interval between the annotations. When activated,
the sounder automatically generates annotations containing the
current time at the chosen interval.

Event

Each event annotation is identified with an individual event
number. The event annotation is then generated every time an
event is generated. The event number is initially chosen here,
and thereafter automatically incremented or decremented every
time a new event is generated.
To generate an event, click Event in the Status bar.
The Event annotation can include current time and/or current
longitude and latitude. Click applicable Add Time or Add
Navigation to select. Without time or position data selected, the
annotation message will simply contain the event number.

External events

External annotations may be input via the serial port for
navigation as an NMEA telegram. The Annotation dialogue
box does not support direct control of this function.
The external annotation has the following format:
$??ATS,this is a test<CR><LF>
The telegram header consists of:
1 the $ character
2 two letters ?? (disregarded by the echo sounder, identifies

the sender of the telegram)

3 three letters ATS (Annotation Text String - identifies the
type of NMEA telegram).

4 a comma (NMEA separation character).
5 Text string (The echo sounder handles the string as an

ordinary text. You can not use commas in the text string.)
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6 A carriage-return and line-feed pair completes the
telegram.

The ASCII telegram with the external annotation must be
connected to the same serial line as the navigation system.

Related topics

→ Status Bar, page 64
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BI 500
The BI 500 dialogue box is opened from the Install menu.
The EQ60 echo sounder may communicate on an ethernet line
with the BI 500 post-processing software. This dialogue box is
used to set up the parameters for this communication, and to
define which information the BI 500 shall receive.

Datagram
You can specify which datagrams to be transmitted to the BI
500 computer:
Parameter- Check this box if you want to transmit parameter
data. The parameters required by BI 500 are sound velocity,
frequency, pulse length and transducer type.
Echogram - Check this box if you want to transmit echogram
data (surface and/or bottom related). Note that this data is
required by the BI 500.
Echo Trace - Check this box if you want to transmit echo trace
data.
Navigation - Check this box if you want to transmit the
Navigation datagrams selected in the Navigation Interface
dialogue box. Navigational data is required if you intend to use
the map function in BI 500.
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Vessel Log - Check this box if you want to transmit VesselLog
datagrams. This datagram is required by BI 500 and is
automatically generated based on the vessel speed.
You will normally transmit all the datagrams when operating
EQ60 together with BI 500. If you do not use the BI 500, do not
export any datagrams.
The Echogram, Echo trace and Vessel log datagrams are
identical to the corresponding datagrams transmitted by the
Simrad EK500 echo sounder.

Distance

Use this parameter to (re)set the internal log distance counter.
The current value of the log distance counter is shown at the
time the BI 500 dialogue box was opened.

Echogram

You can here specify the layout of the echogram datagram.
No. of Surface Values - this value defines the number of
surface based echogram values to be filled into the echogram
datagram. This number should be 500 (default) when operating
with the BI 500 post-processing software.
No. of Bottom Values - this value defines the number of bottom
based echogram values to be filled into the echogram datagram.
This number should be 150 (default) when operating with the BI
500 post-processing software.
Surface Range - Click this button to enter the Surface Range
dialogue box. Here you specify the operating range for the
surface echogram.
Bottom Range - click this button to enter the Bottom Range
dialogue box. Here you specify the operating range for the
bottom echogram.

Ethernet

These parameters are used to define the Ethernet connection
with the BI 500 computer.
The Remote UDP Port and the Remote IP Address specified
must correspond to the UDP port number and Internet address
used by the BI 500 computer.

Related topics

→ Surface Range, page 110
→ Bottom Range, page 77
→ Navigation Interface, page 95
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Bottom Detector
The Bottom Detector dialogue box is opened when you
right-click on the numeric depth value in the Header view on
the display.

This dialogue box is used to define the upper and lower depth
limits most likely to be used during the echo sounder operation.
These limits may be used to obtain ”bottom lock” on the depth
when the echo sounder is pinging. The sounder needs this lock
to locate the correct depth, and to stay on it during the
operation, even though the depth changes continuously.
The dialogue box is also used to set alarms to notify you if
maximum or minimum depths are exceeded.

Parameters

Minimum Depth - The bottom detector starts the search for the
bottom echo at this depth. The detector will fail in shallow
water if you select a too large depth value, and the tail of the
transmitting pulse may cause problems if a too small value is
set.
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Maximum Depth - The search for the bottom echo extends
down to this depth whenever bottom track is lost. Enter a
slightly larger depth value than the deepest spot you expect to
visit in order to avoid annoyingly long ping intervals every time
bottom track is lost. A depth value of either 0 or less than the
minimum depth disables the bottom detector.
Bottom Lost Warning - A warning is activated whenever
bottom track is lost. The warning is presented as a message in
the Status bar and as an audio signal.
Min. Depth Alarm - An alarm is activated whenever the
detected bottom depth is smaller than the chosen alarm
threshold. The warning is presented as a pop-up message and as
an audio signal. When the depth value is set to 0, this function is
disabled.
Max. Depth Alarm - An alarm is activated whenever the
detected bottom depth exceeds the alarm threshold The warning
is presented as a message on the display and as an audio signal.
When the depth value is set to 0, this function is disabled.
Backstep Min. Level - After the estimated depth of the bottom
detector, the detected depth is automatically adjusted by
stepping back according to the value of the setting you have
chosen. This allows the EQ60 to verify that the correct bottom
depth has been located. If the value you enter is too large (close
to 0 dB) the adjustments will be very small.
The default value is -50 dB.
Bottom Smoothing - If bottom track is lost, the detected
bottom depth is repeated for a maximum of three consecutive
pings.
Alternative Bottom Detector - This bottom detector resembles
the Simrad ES 380 bottom detector algorithm. This function
may be useful in a steep bottom slope situation.
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Bottom Range
The Bottom Range dialogue box opens if you click the right
mouse button in the range field in the Echogram and Range
view while operating with a Bottom Range echogram.
The different echograms are explained in the Echogram
dialogue box.

Range - This parameter controls the vertical depth range across
the echogram.
Stop Relative Bottom - This parameter controls the depth offset
at the lower boundary of the echogram relative to the detected
bottom; positive values downwards.
Note that you can also change the range using the mouse wheel.
This is described in the Echo frames chapter.

Related topics

→ Echogram, page 81
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Colour Scale

The Colour Scale dialogue box is opened when you right-click
on the colour scale in the Header view.

This dialogue controls the mapping of echo strength into one out
of 12 colours, light blue for weak signals and dark brown for
strong signals. Each discrete colour represents a 3 dB range of
echo signal strength implying that the next colour is selected
every time the echo strength doubles.

Parameters

A high numeric value displays weak echo signals properly while
the stronger signals saturate into dark brown colour. A low
numeric value displays strong echo signals properly. Weak
signals below the lower limit of the colour scale are not
displayed (the display background colour is used).

School Gain - This parameter controls the display sensitivity of
the echo sounder down to the detected bottom depth when
School Gain is selected in the Echogram dialogue box. A
numeric value of 70 sets the lower limit of the echogram colour
scale equal to a volume backscattering strength of -70 dB.

Fish Gain - This parameter controls the display sensitivity of
the echo sounder down to the detected bottom depth when Fish
Gain is selected in the Echogram dialogue box. A numeric
value of 50 sets the lower limit of the echogram colour scale
equal to a target strength of -50 dB.
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Limit gain regulation - Due to the high dynamic range in the
EQ60 echo sounder, invidious gain settings may result in
unwanted noise. This will also cause the fish size estimates to be
erroneous. This gain regulation setting will limit the receiver
gain to maximum 100 dB. The limitation will prevent the echo
sounder from saturation.
Bottom Gain - This parameter controls the display sensitivity
of the echo sounder below the detected bottom depth. A
numeric value of 70 sets the lower limit of the echogram colour
scale equal to a surface backscattering strength of -70 dB.
No TVG - This parameter controls the display sensitivity of the
echo sounder when No TVG is selected in the Echogram
dialogue box. A numeric value of 70 sets the lower limit of the
echogram colour scale equal to a measured input level of -70
dB.

Removing colours

By left-clicking on the colours in the colour rectangle in the
upper right-hand corner of the screen, the selected colour will
become the weakest colour shown in the Echogram and Single
Echo views.
To restore the colour range, click on the removed colour’s
position.
Note that this is a display function only. It does not have any
effect on the sounder’s performance. It will however affect the
recordings made by the History function.

Related topics

→ Echogram, page 81
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Depth Output
The Depth Output dialogue box is called from the Heave
Sensor, Trawl Interface and Navigation Interface dialogue
boxes. These are in turn accessed from the Install menu.
It allows you to control the depth data output.

Parameters
Depth output - Check to enable the depth output.
Checksum - A checksum may optionally be appended to the
NMEA output telegrams (according to the NMEA standard).
Channel - NMEA depth telegrams are only output from one
channel at a time. Select channel from the list of installed
frequency channels.
The GPT uses its Ethernet address for unique identification, and
the PCT uses its ISA bus parameters; IO address, DMA channel
and IRQ number. The channel number identifies individual
channels within a multi-channel transceiver.
Telegram - The echo sounder can output three different types of
NMEA depth telegrams. However, only one telegram type at a
time can be generated. You can select the telegram type here.
• The $SDDBS telegram contains the depth below the surface.
• The $SDDBT telegram contains the depth below the

transducer.
• The $SDDPT telegram contains the depth below the

transducer and the distance between the transducer and the
waterline.

The EQ60 can also output the EA 500/EK500 compatible depth
telegrams; D1, D2 etc. Output for Atlas echo sounders are also
provided.

Related topics
→ Trawl Interface, page 116
→ Heace Sensor, page 88
→ Navigation Interface, page 95
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Echogram

The Echogram dialogue box is opened by right-clicking on the
echogram in the Echogram and Range view on the display.
This dialogue is used to control the type and presentation of the
echograms.

Echogram

Surface - Manual - The echogram is related to the sea surface.
Start depth (upper echogram boundary) and vertical range
(across echogram) are manually selected in the Surface Range
dialogue box.

Surface - Auto Range - The echogram is related to the sea
surface. Start depth is manually selected in the Surface Range
dialogue box. The EQ60 performs automatic adjustment of the
vertical range keeping the bottom echo inside the visible
echogram.
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Surface - Auto Start - The echogram is related to the sea
surface. Vertical range is manually selected in the Surface
Range dialogue box. The EQ60 performs automatic adjustment
of the start depth keeping the bottom echo inside the visible
echogram.
Bottom - The echogram is related to the detected bottom. Stop
depth (lower echogram boundary) and vertical range are
manually selected in the Bottom Range dialogue box. The
echogram is only drawn for pings having a successful bottom
detection.
Trawl - Trawl sensor systems communicate headrope depth and
headrope-to-footrope distance to the EQ60 at regular intervals.
The echogram covers the vertical opening of the trawl including
a small margin at each side. The headrope and footrope margins
are identical. Their size is selected in the Trawl Range dialogue
box. The headrope-to-footrope distance can be manually set in
the Trawl Interface dialogue box for trawl sensor systems not
measuring the trawl opening, or when the measured
headrope-to-footrope distance is unreliable. The echogram is
only drawn when trawl position information is available.

Horizontal Depth Lines

Scale - Equidistant horizontal scale lines are drawn inside the
echogram in the current foreground colour; black during day
and white during night. A maximum of 50 scale lines can be
drawn. No scale lines are drawn when the scale line count is set
to zero.
Bottom:
• On - The detected bottom depth is shown as a thin line in the

echogram. The line is drawn in the current foreground
colour; black during day and white during night.

• Off - The bottom line is switched off.
• White Line - A band in the current background colour is

drawn below the detected bottom depth.
Variable Depth - When enabled a horizontal depth line is
placed wherever you click in the Echogram view. The depth of
the line is displayed at the left end of it. In the History diagram
the depth for each ping is displayed individually.
Trawl - Headrope and footrope depth are indicated by two red
lines in the echogram. Continuous lines are drawn when the
current depth values are available, and dotted lines are drawn
for a period of two minutes when this information is not
available. No lines are drawn after two minutes.
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Range other - Two horizontal lines indicate the range presented
in the lower echo frame.
Purse Seine - The depth of the purse seine sensor is indicated.

Vertical Markers

Event - A vertical line is drawn when a new event is generated.
Minute - A short vertical line is drawn in the upper part of the
echogram once every minute.
New Range - A vertical line is drawn when the range is
changed. The old range is written on the screen as an
annotation.

Gain

No - No TVG is applied. The echogram displays the input
power level at the transducer terminals. This echogram type is
used for special purposes when TVG is not applicable or
required..
School - The echogram displays volume backscattering strength
above the detected bottom, and surface backscattering strength
below the detected bottom. Volume backscattering strength is
suitable when observing a school of fish, and surface
backscattering strength is suitable when studying the properties
of the bottom.
Fish - The echogram displays target strength above the detected
bottom and surface backscattering strength below the detected
bottom. Target strength is suitable when observing individual
fish, and surface backscattering strength is suitable when
studying the properties of the bottom.

RCG (Reverberation Controlled Gain)

Apply this filter to enhance the detection of single fish on a
background of reverberation or noise.

Ping Filter

The ping-to-ping filter ”cleans up” the echogram by removing
random noise spikes with no correlation with the previous ping.
The function will thus make echoes appear more stable.
The ping filtering effect may be varied using the three different
settings provided, or it may be switched off.
Weak - Only two pings are correlated
Medium - Four pings are correlated
Strong - Eight pings are correlated.
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Related topics

→ Surface Range, page 110
→ Bottom Range, page 77
→ Trawl Range, page 118
→ Trawl Interface, page 116
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Environment
The Environment dialogue box is available from the Install
menu.
Many other echo sounders are calibrated to a sound velocity of
1500 m/s. If the EQ60 is used together with other sounders it is
advantageous to adjust the sound velocity on the EQ60 as well,
in order to have the same depth readings.

Salt Water / Fresh Water - Propagation losses due to
absorption are much higher in sea water than in fresh water.
Correct compensation for these losses therefore relies on the
echo sounder knowing which water type is present.
Sound Velocity - For accurate measurement of bottom depth the
correct sound velocity must be entered. Normally, 1470 m/s is a
good average value.
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Shutdown
The Shutdown command is available from the File menu.
Select this command to terminate the echo sounder program.

Note You must always use this command before you turn off power!

Related topics

→ File, page 58
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Factory settings
The Factory Settings dialogue box is accessed from the
Options menu. It does not provide specific parameters, but
simply allows you to acknowledge the chosen function.
Restoring factory settings is normally used only if you need to
restore the echo sounder after long time use, or if you have
made a number of incorrect selections in the menus or dialogue
boxes and wish to correct these fast.

When selected, this function will first stop the echo sounder
operation.
Second, all the personalized settings you have entered will be
removed. These include all the parameters you have chosen for
the operation, as well as changes you have made with the echo
sounder screen layout. The settings made for communication
(serial lines) and installation (transceivers and transducers) are
not affected. The only way to restore the operational settings is
to enter them all one more time.

Third, the echo sounder is restarted using the default settings
chosen by Simrad. These are considered generic, and they are
the same settings as when you first switched on the echo
sounder.
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Heave Sensor
The Heave Sensor dialogue box is accessed from the Install
menu.
If you wish your echogram and detected bottom depth to be
heave corrected, you need to connect the EQ60 to a heave
sensor.

Source Selection

Off - Disregard all heave input.
Analog - Heave sensors with analogue outputs are connected
directly to the Auxiliary Connector of the nearest General
Purpose Transceiver (GPT). Select the appropriate transceiver
from the list of installed transceivers. Each entry in the list
contains transceiver type, operating frequency and unique
identifier.
The transceiver accepts a ±10V differential input signal. A fixed
scaling factor equal to 1 V/m is programmed.
The GPT uses its Ethernet address for unique identification.
The PC Transceiver uses its ISA bus parameters; IO address,
DMA channel and IRQ number.
The channel number identifies individual channels within a
multi-channel transceiver.
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Serial Line - Heave sensors with a serial line output are
connected to a RS-232 port at the rear of the echo sounder’s
processor unit.
Protocol - These options are only available when Serial Line
has been chosen. Use these to select serial line input format. The
echo sounder recognises one character based telegram
(Sounder/TSS1) and two binary telegrams (EM 1000 and EM
3000).

Data Input

The most recent input data is displayed in a list. With analogue
input the input voltage and the computed heave value are
displayed. With serial line input the telegram content is
displayed. This function is useful during installation and trouble
shooting. The current heave value is displayed in meters in the
lower left corner of the dialogue box.
Clear - This button clears the input data list.

Depth Output

This opens the Depth Output dialogue box.

RS-232

This button activates the RS-232 Setup dialogue box. This box
is used to define communication port, baud rate etc.

Related topics

→ Depth Output, page 80
→ RS-232 Setup, page 107
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History
The History dialogue box is accessed from the View menu.
It displays echogram views previously saved during normal
echo sounder operation. This function greatly reduces the need
for echogram printout on paper. The presentation is made in a
separate window, and the echo sounder operates normally in the
background.
Note that the number of history files is limited to 400 in the
same directory.
Echograms covering the past hours can be viewed by operating
the scroll bar at the bottom of the dialogue; the oldest echogram
view to the left, the newest echogram view to the right.
Click the button in the lower right corner if you wish to print the
current view. If you wish to print a series of echograms click the
button with the + sign.
The echograms stored in the history files are available on
*.BMP format on the harddisk. A directory for these were
created during the installation: c:\EQ60\history.
Recording, browsing and printing the history information is
described in the Operational procedures chapter. More detailed
information about the History window is provided in the
Display views chapter.

Related topics

→ Operation, page 97
→ History recording, page 49
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IP Address
The IP Address dialogue box is used when you need to change
the echo sounder’s addressing.
Note that this operation is not required on a daily basis. You
only need to modify the address if your echo sounder system
shall be connected to an existing computer network on the
vessel. As long as the EQ60 operates as a stand-alone system
using the hardware supplied by Simrad, you will not need to
change anything.
To access this dialogue box, open the Transceiver Installation
dialogue box from the Install menu, select a transceiver, and
click Set new GPT IP Address. The echo sounder will stop
automatically.

If you need to change the address, keep 157 and 237 as the two
first bytes, as these are common for all Simrad equipment. The
two remaining digits can be chosen freely, provided that no
other Simrad equipment with the same address is connected to
the same network. Thus, if you operate with more than one
GPT, these must be set up with different IP addresses.

Background theory

IP addresses are shown as four decimal integer numbers, where
each integer number corresponds to eight bits (or one byte) of
the address.
An IP address consists of a network address and a host address.
Three address classes are defined:
Class A used on large networks:
0NNNNNNN HHHHHHHH HHHHHHHH HHHHHHHH
Class B used on medium size networks:
10NNNNNN NNNNNNNN HHHHHHHH HHHHHHHH
Class C used on small networks:
11NNNNNN NNNNNNNN NNNNNNNN HHHHHHHH



Simrad EQ60

92 857-164342 / Rev.C

The address class is determined from the high-order bits of the
first byte.
• The first byte of a Class A address contains a zero and seven

network bits. The next 24 bites identify the host.
• A Class B address contains a one, a zero, 14 network bits and

16 host bits.
• Finally, a Class C address contains a one, a one, 22 network

bits and 8 host bits.
The echo sounder computer, GPT transceiver(s) and other
computers that communicate on the ethernet must reside on the
same network. This requirement is met only if the host part of
the address differs.

Related topics

→ Transceiver Installation, page 112
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Language
The Language dialogue box is accessed from the Options
menu. Use this dialogue to select operational language.



Simrad EQ60

94 857-164342 / Rev.C

Layout
The Layout dialogue box is accessed from the View menu.
Installed frequency channels are visible on the display or
hidden. This dialogue box controls how many frequency
channels are visible and their layout on the display.

Arrangement

Visible frequency channels are vertically or horizontally
arranged on the display. Automatic selection of layout is also
provided.

Channels

The list of installed frequency channels is displayed; one
channel per line.
Each entry contains a check box, transceiver type, operating
frequency, unique identifier, channel number and transducer
type.
• The PC Transceiver uses its ISA bus parameters for unique

identification; IO address, DMA channel and IRQ number.

• The General Purpose Transceiver (GPT) uses its Ethernet
address. The channel number identifies individual channels
within a multi-channel transceiver.

Select visibility by clicking the boxes.
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Navigation Interface

The Navigation Interface dialogue box is accessed from the
Install menu.

A navigation receiver or other navigational instrument can be
connected to a RS-232 port of the EQ60 Processor Unit. The
input may be either standard NMEA datagrams or user specific
ASCII datagrams. Standard NMEA datagrams are automatically
interpreted, like the GGA and GLL navigation sentences.

Special $??ATS or CS datagrams (defined by Simrad) may
contain an external annotation message. See the Annotation
dialogue box for further information about annotations.

Position input protocol

Tick for the appropriate input protocol; ASCII or NMEA. For
setup of these protocols, see the Advanced Navigation dialogue
box. This dialogue box is accessed with the Advanced button.
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Speed input

External - to be used if navigational data is input from an
external source into EQ60. The current vessel speed value is
shown (when external speed input is selected)
Manual - only to be used if external speed data is unavailable or
unreliable.

Data Input

Data Input - The most recent input data are displayed in a list.
This function is useful during installation and troubleshooting.
Clear - This button clears the list of input telegrams.

Depth Output

This opens the Depth Output dialogue box.

RS-232

This button activates the RS-232 Setup dialogue box. This box
is used to define communication port, baud rate etc. The NMEA
standard specifies 4800 bits per second, 8 bits per character, 1
stop bit, no parity.

Related topics

→ Annotation, page 70
→ Advanced Navigation, page 66
→ Depth Output, page 80
→ RS-232, page 107
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Operation

The Operation dialogue box is accessed from the File menu.

This is the main dialogue box for operational control. You can
select operational mode and ping rate, and you can initiate
recording of the echo sounder information. The sounder has two
functions to greatly reduce the need for echogram printout
paper: Store/Replay and History.

The Store/Replay function records the unprocessed transceiver
data on the internal harddisk. These data are later injected into
the echo sounder processing software as if it arrived directly
from the transducer. When replaying the recorded signal, you
are free to experiment with the echo sounder settings.

This feature is useful during training and demonstration. It is
also useful for memorising a particularly interesting observation
out at the fishing grounds.

The Store dialogue box is available from the File menu. The
Replay dialogue box is available from this dialogue box when
you click on the Files button.
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The History function is equivalent to the print function. The
echo sounder continuously saves echogram ”printouts” or
echogram pictures to the internal harddisk. These can later can
be recalled on the display.
The horizontal width of each echogram picture roughly
corresponds to the width of the display. History memory is
organised as a circular loop; the newest echogram picture
overwrites the oldest one. The circular memory holds several
hours of echogram recording. The history function allows you
to quickly look through echogram pictures covering the past
hours.

Mode

The echo sounder either pings normally displaying the echo
signal received at the transducer, or it replays a previously
recorded echo signal stored in one of the four Raw Data
Memory locations.
Normal - Click the Normal button to enter Normal ping mode.
Replay - Select Replay for Replay (playback) mode.
Files - When selecting Replay mode, click the Files button to
activate the Replay dialogue to select the replay file.

External trigger

The Auxiliary connector on the General Purpose Transceiver
(GPT) includes a trigger input signal for transmit
synchronisation with external equipment. Normally, the EQ60
transmits as soon as it is ready for the next ping. Transmission is
delayed until a pulse is detected at the trigger input line when
the Extern Trig entry is checked.
Click this option to enable the EQ60 to work in Slave mode.
The echo sounder will then await the external trigger from the
peripheral system, and the transmissions from the systems will
be synchronized.
When this option is not checked, the EQ60 operates normally as
a Master system.
The external triggering system is explained in more detail in the
EQ60 instruction manual. Refer to the Cable layout chapter in
the printed book.

Note External transmit synchronisation is only active in Normal ping
mode.

History

Echogram pictures are saved continuously to the harddisk when
the Save box is checked.
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To select folder for the saved files, click Browse.

Ping rate

These settings are used to define how fast the echo sounder shall
transmit (”ping”). When the Maximum box is selected, the
EQ60 transmits at maximum speed only limited by the speed of
sound in water and/or processing delays. Selecting Single Step
allows the EQ60 to conduct just one ping cycle every time the
Step! entry on the Main menu is clicked, or the keyboard
comination Alt+E is pressed.
Selecting Interval sets the echo sounder to transmit once at
every chosen time interval (in seconds).

Related topics

→ Store, page 108
→ Replay, page 105
→ Playback and recording procedure, page 47
→ History procedure, page 49
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Printer and History
The Printer and History dialogue box allows you to control
the output to the system’s colour printer.
The dialogue is accessed by the Print command on the File
menu.

Print

Check this box if you want the echogram printing to be active.
If the printer is switched on and active, a small printer symbol is
shown inside the Status bar.

Text to Printer

Status - Check this box if you want status messages to be
printed.
Navigation - Check this box if you want position strings to be
printed. Navigation receivers typically output a new position fix
every second, and it is not practical to print them all on top of
the echogram. The count parameter in the spin box reduces the
rate of printing of the position strings. Every tenth position fix is
printed when this parameter is set to ten.
Annotation - Check this box if you want annotations to be
printed.
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Text background

Click to select either opaque or transparent text background on
the annotation printouts.

Echogram speed

Select any of these values to slow down the printout relative to
the echo sounder speed. The ping rate will not be changed.

Print Setup

Click this button to access the Print Setup dialogue box.

Related topics

→ Annotations, page 70
→ Print Setup, page 102
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Print Setup

The Print Setup dialogue box is accessed from the Printer and
History dialogue box. Note that this dialogue box is a part of
the operating system, and the language displayed is that of the
operating system.

The EQ60 echo sounder uses the print mechanism of the
Microsoftt operating system when sending the echogram to a
printer. Virtually any modern printer can be used. This Print
Setup dialogue box controls the printing process. Installation of
a new printer is done with the operating system’s built-in
dialogue boxes. This is not described in this documentation.
Refer to the operating system’s documentation.

Printer

Name - This entry displays the logical name of the printer. A
typical EQ60 will normally have only one printer installed.
However, if you for some reason have more than one printer
installed, the Name box controls which printer to use.

Status - This field displays the status of the printer: ready, busy
etc.

Type - The type of printer is displayed.

Where - The name of the interface to the printer is displayed.

Comment - Any comment that was entered during the
installation of the printer appears here.
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Properties - This button activates the Properties dialogue box.
This is a printer specific dialogue for entering special purpose
printer parameters. You do not need to enter this dialogue box
during normal operation of the echo sounder. The Properties
dialogue box is part of the operating system. For further
information about this dialogue box, refer to the operating
system documentation.

Paper

Size - Modern printers support a variety of paper sizes.
However, the sizes A4 or Letter are appropriate when printing
echogram on paper.
Source - This setting tells advanced printers which paper tray to
use. The setting Automatic Select works on most printers.

Orientation

Select Portrait or Landscape. Landscape orientation is
recommended for echogram printing.

Network

This button activates the Network dialog box. It is used to send
print jobs to a remote printer on a data network. Clearly, this is
not the situation on a standard fishing vessel. Hence, during
normal operation you do not need to enter this dialog box.
The Network dialogue box is part of the operating system. For
further information about this dialogue box, refer to the
operating system documentation.

Related topics

→ Printer and History, page 100
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Purse Seine
The Purse Seine dialogue box is accessed from the Install
menu. Use the settings from this dialogue to set up the interface
to the purse seine system.

Depth Output

This opens the Depth Output dialogue box.

RS-232

This button activates the RS-232 Setup dialogue box. This box
is used to define the communication port used to interface the
purse seine system. You need to know the communication
parameters to set this up. The NMEA standard specifies 4800
bits per second, 8 bits per character, 1 stop bit, no parity. You
must check to the purse seine documentation if these settings do
not work.

Data input

This is a text field where you can monitor the data telegrams
received from the purse seine system. The information will
scroll through the field. The purpose of this is only to confirm
that the communication is working properly. To clear the field,
press the Clear button.

Related topics

→ Depth Output, page 80
→ RS-232 Setup, page 107
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Replay

This Replay dialogue box is accessed from the Operation
dialogue box by clicking on the Files button. The Operation
dialogue is in turn opened on the File menu.

The Store function records the unprocessed transducer signal on
the internal harddisk or an other recordable media. The recorded
signal can later be injected into the echo sounder processing
software as if it arrived directly from the transceiver (Replay).

The Store dialogue box (also available from the File menu)
controls the recording of the unprocessed signal on the harddisk,
while this Replay dialogue controls the playback of this signal
into the echo sounder processing software.

Survey (directory)

This is a standard file selector. Select survey directory first, and
then one or more files to be replayed.

Selected Files

The currently selected files are displayed in this field.



Simrad EQ60

106 857-164342 / Rev.C

Loop

Check this box if you want the EQ60 program to loop through
the currently selected replay files without stopping.

Save Output Data

Check this box if you want to store processed output data. This
data are used by post-processing software when generating
bottom contour maps.

Related topics

→ Store, page 108
→ Playback and recording procedure, page 47
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RS-232 Setup
The RS-232 Setup dialogue box is accessed from several other
dialogue boxes. It specifies the RS-232 communication settings.
Identical settings must be used at the opposite side of the
RS-232 cable.

Parameters

Port - Which RS-232 port do you want to use?
Baud Rate - Select communication rate.
Data Bits - Do you want to use 7 or 8 data bits per character?
Eight data bits per character are standard.

Stop Bits - One or two stop bits?
Parity - Do you want to use bit 8 for error checking?
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Store

The Store/Replay function records the unprocessed transceiver
data on the internal harddisk. The recorded signal can later be
injected into the echo sounder processing software as if it
arrived directly from the transducer. The Store dialogue is
accessed from the File menu. It controls the recording of the
unprocessed signal on the harddisk. The Replay dialogue box
(available from the Operation dialogue box) controls the
playback of this signal into the echo sounder processing
software.

Survey

Enter the complete path name of the survey directory. A new
directory is created if it does not exist. The new directory is
created when you click the OK button. Click the Browse button
if you wish to navigate through the disk directories.

Data formats

Save Raw Data - Check this box if you want to store the
unprocessed transceiver data on the internal harddisk. The
unprocessed transceiver data is stored in standard computer
files. These files contain all the necessary data for realistically
reconstructing the situation during the real survey; transceiver
data, navigation data, annotation input etc. The echo sounder
program reads these files during replay.
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Save Output Data - Check this box if you want to store
processed output data on the internal harddisk; position fixes,
bottom detections, annotations. This data are used by the
post-processing software when generating bottom contour maps.

Line No.

Enter the initial survey line number. A toggle button inside the
Status bar on the display controls the start and stop of each
survey line. The line number is automatically incremented (or
decremented) by one for every new survey line. Click the box
and local time will be used in the file names, otherwise GMT is
used.

Max File Size

Enter the maximum size of each replay file. The replay file
contains the unprocessed transceiver data. Several kilobytes of
sample data is written into this file every ping. All sample data
may be contained in just one file for short survey lines.
However, the amount of data grows rapidly as the survey lines
become longer, and it may be necessary to split the data into
fragments which are stored in sequential replay files.

Related topics

→ Operation, page 97
→ Replay, page 105
→ Playback and recording procedure, page 47
→ Size control, page 48
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Surface Range
The Surface Range dialogue box opens if you click the right
mouse button in the range field in the Echogram and Range
view while operating with a Surface Range echogram.
The different echograms are explained in the Echogram
dialogue box.

Parameters

Range - This parameter controls the vertical depth range across
the echogram.
Start Relative Surface - This parameter controls the depth at
the upper boundary of the echogram, relative the transducer
face.
Note that you can also change the range using the mouse wheel.
This is described in the Echo frames chapter.

Related topics

→ Echogram, page 81
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Temperature Sensor
The Temperature Sensor dialogue box is accessed from the
Install menu. Water temperature is shown on the echo sounder
display provided a thermistor (temperature sensitive resistor, 10
kohm at 25 deg C) is interfaced to the system.
The thermistor wires are connected directly to the Transducer
connector.

Analog Input - Select the appropriate transceiver from the list
of installed transceivers. Each entry in the list contains
transceiver type, operating frequency, unique identifier, channel
number and transducer type. The GPT uses its Ethernet address
for unique identification.
Data Input - The most recent input data are displayed in a list.
Measured thermistor resistance and the computed temperature
value are displayed. This function is useful during installation
and troubleshooting.

Clear - This button clears the input data list.
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Transceiver Installation
This dialogue box controls installation and un-installation of
transceivers. The dialogue box is accessed from the Install
menu. Prior to this, all echo sounder activity must be stopped.
When accessed, an opening dialogue allows you to either:
• Inspect the transceiver installations
• Modify the transceiver installations
• Cancel the operation
Every time the Transceiver Installation dialogue appears on
the display the echo sounder software performs a search for
transceivers. The ISA bus is searched for PC Transceiver
plug-in boards, while General Purpose Transceivers (GPT)
connected to the Ethernet interface are identified. The complete
transceiver list is then displayed.

Transceiver list

A single frequency transceiver occupies one entry in the list, and
a dual frequency transceiver occupies two. Each entry contains:
• transceiver type
• operating frequency
• unique identifier
• frequency channel number
• transducer type
The General Purpose Transceivers use their Ethernet addresses
for unique identification.
The PC Transceivers use their ISA bus parameters; IO address,
DMA channel and IRQ number for identification.
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The frequency channel number identifies individual channels
within a multi-frequency channel transceiver.

Frequency channels

Hence, the echo sounder system consists of a number of
frequency channels. Entries in the frequency channel list are
shown in black, green or red colour. Detected channels that are
not installed are shown in black. The phrase NONE replaces the
transducer type name for uninstalled channels. Detected
channels that are installed are shown in green colour. Installed
channels that were not detected during the search for
transceivers are shown in red colour.
Each entry in the Frequency Channel Selection list belongs to
a transceiver. The lower part of this dialogue box displays
information about the currently selected transceiver. The first
information line displays the transceiver personality string.
Remaining lines display specific transceiver information.

Set new GPT IP Address

The communication on the Ethernet network between the echo
sounder computer and the General Purpose Transceiver(s)
complies to the TCP/IP (Transport Control Protocol / Internet
Protocol) family of protocols. Every host (GPT or computer)
connected to the network must have a unique 32-bit IP address.
To modify the GPT IP address, refer to the IP Address dialogue
box.

Related topics

→ To install or uninstall a channel, page 45
→ To modify an IP Address, page 46
→ IP Address, page 91
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Transceiver Settings
The Transceiver Settings dialogue box is accessed from the
Header view on the display. Place the cursor on top of the mode
and frequency information, and press the right mouse button.
This dialogue box controls transceiver and transducer
parameters specific to the current frequency channel.
A text line at the top of the dialogue box identifies the
frequency channel. This identification line contains:
• transceiver type
• operating frequency
• unique identifier
• channel number
• transducer type
The General Purpose Transceiver (GPT) uses its Ethernet
address for unique identification.
The PC Transceiver uses its ISA bus parameters; IO address,
DMA channel and IRQ number for unique identification.
The channel number identifies individual channels within a
multi-frequency channel transceiver.
A second text line appears in replay mode. This identifies the
name of the replay file.

Mode

Active - The transmitter and receiver are active (normal
operation).
Passive - The transmitter is passive while the receiver is active.
This mode of operation is useful for test purposes, and when
you wish to measure the ambient background noise in the sea.
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Test - The transmitter is passive and the receiver is active. Each
General Purpose Transceiver board includes a signal generator
injecting a weak test signal (-70.0 dBW) into the receiver’s
input circuitry. The nominal power reading at the display is
-70.0 dBW for channels using one transceiver board (1 kW
single beam) and -64.0 dBW for channels using four boards (4
kW single beam, 4 kW split beam).
The PC Transceiver does not include any test generator, and
there is no difference between the Test and the Passive settings.

Transmit Power
This parameter controls the transmitter’s output power. Output
power is limited either to the maximum rating of the transducer,
or the maximum rating of the transmitter, whichever is the
smallest.

Pulse Length
This parameter controls the duration of the transmit pulse.
The table below shows the pulse lengths (given in µS) available
for the different operational frequencies.

-- 64 128 256 512 1024 2048 4096 8192 16384

38 kHz -- -- X X X X X -- --

50 kHz -- X X X X X -- -- --

70 kHz -- X X X X X -- -- --

120 kHz X X X X X -- -- -- --

200 kHz X X X X X -- -- -- --

Table 1 X-axis is pulse length in µS, Y-axis is frequency in kHz. “x” means that the
pulse length is available for the given frequency.

Transducer
Type - The transducer currently connected to the transceiver is
identified.
Depth - In order to measure correct water depth, the echo
sounder needs to know the vertical distance between the vessel’s
water line and the transducer face. Here, enter the depth of the
transducer face relative the waterline.

Note If the Olex system is used, the Depth value must be set to 0
(zero).

Advanced
This button opens up the Advanced Transceiver dialogue box
containing detailed numeric information about the transducer
and the channel.

Related topics
→ Advanced Transceiver, page 68
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Trawl Interface
A Simrad ITI (Integrated Trawl Instrumentation) system can be
connected to a RS-232 port at the rear of the EQ60 computer.
Communication with the ITI system is based on NMEA
telegrams. The EQ60 may transmit depth telegrams to the ITI.
Useful input telegrams from the ITI are automatically
interpreted.
• The $IIDBS telegram contains the headrope depth.
• The @IIHFB telegram contains the vertical distance between

the headrope and the footrope.

Trawl opening
A fixed headrope-to-footrope distance can be manually entered.
This is used for trawl sensor systems not measuring the trawl
opening, or when the measured headrope-to-footrope distance is
unreliable. Enable for manual setting in the check box, and enter
the desired opening.

Data input
The most recent input telegrams are displayed in a list. This
function is useful during installation and trouble shooting.
Clear - This button clears the list of input telegrams.

Other options
RS-232 - This button activates the RS-232 Setup dialogue box
for communication port, baud rate etc.
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Depth Output - This button activates the Depth Output
dialogue box.

Related topics

→ RS-232 Setup, page 107
→ Depth Output, page 80



Simrad EQ60

118 857-164342 / Rev.C

Trawl Range
The Trawl Range dialogue box opens if you click the right
mouse button in the range field in the Echogram and Range
view while operating with a Trawl Range echogram. The
different echograms are explained in the Echogram dialogue
box.

Echogram Margin - Trawl sensor systems communicate
headrope depth and headrope-to-footrope distance to the
sounder at regular intervals. The trawl echogram covers the
vertical opening of the trawl including a small margin above and
below. The headrope and footrope margins are identical.
Note that the headrope-to-footrope distance can be manually set
in the Trawl Interface dialogue box. This is used for trawl
sensor systems not measuring the vertical trawl opening, or
when the measured headrope-to-footrope distance is unreliable.

Related topics

→ Echogram, page 81
→ Trawl Interface, page 116
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INSTALLATION

Introduction
This chapter contains the necessary information for installation
of the various units comprising the Simrad EQ60 echo sounder.

Hardware items

→ Basic installation procedure (overview), page 120
→ Parts and configurations, page 122
→ General Purpose Transceiver (GPT) installation, page 125
→ Printer installation, page 126

Cables and interfaces

→ Cable layout, page 129
→ External interfaces, page 134

Transducers

→ Transducer installation, page 173
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Basic procedure

Purpose
The basic installation procedure is presented here. Detailed
technical information can be found in the next chapters. The
applicable page references are made in the procedure.

Parts configuration
Check that you have received all parts required for the
installation; cables, connectors, brackets etc.

Transducer(s)
Install the transducer(s) and the transducer cables according to
the guide-lines in this manual and the drawings provided with
the transducer.
Install the two-wire cable for the temperature sensing thermistor
if applicable.

Display with built-in Processor Unit
Mount the display using the appropriate brackets. Connect the
pointing device.

Stand-alone Processor Unit
The EQ60BB is supplied without the display. Mount the
Processor Unit using the appropriate brackets. Connect the
pointing device.

Note Make sure that there is a reliable ground connection between the
computer and the ship’s ground.

Connect the computer and display power cables, and the
display’s VGA cable.

General Purpose Transceiver
The General Purpose Transceiver (GPT) is an optional add-on to
the EQ60 echo sounder. It will provide additional transducers
and frequency channels.
Mount the General Purpose Transceiver using the appropriate
brackets.
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Connect the transducer cable and the power cable.
Connect the cable from the temperature sensor (if applicable).
Install a two-wire cable for remote on/off of the GPT’s.

Interfaces

Ethernet

An Ethernet cable must be used between the transceiver and the
computer if your system includes a General Purpose Transceiver
(GPT).
If only one GPT is used, you need a twisted pair cable with
swapped receive and transmit wires. The cable is connected
between the GPT and the echo sounder’s Operator Station.
An Ethernet hub is required if your system includes more than
one General Purpose Transceiver.

Note Straight through ethernet cable must be used.

Serial lines

Connect navigation receiver, trawl system and heave sensor with
serial line output to the rear of the echo sounder computer using
RS-232 cables. Heave sensors with an analog output are
connected directly to the Auxiliary connector of the nearest
transceiver.

Synchronization

Synchronous transmission is desirable if there are several echo
sounders onboard the vessel. For every echo sounder and every
transceiver onboard the ship, connect the appropriate pins at the
Auxiliary connectors together using a two-wire cable.

Related topics

→ Parts and configuration, page 122
→ Transducer installation, page 173
→ Transducer cables wiring, page 153
→ Remote control connection, page 150
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Parts and configurations

Overview

The Simrad EQ60 echo sounders is designed as a modular
system. It supports a variety of configurations and frequency
options.

A standard EQ60 fishery echo sounder delivery consists of:

• Transducer(s)

• Display Unit with built-in Processor Unit

• Pointing device (mouse or rollerball)

• Optional devices:

- Ethernet switch (if the system comprises more than one
General Purpose Transceiver (GPT))

- Transceiver(s)
The EQ60BB is supplied without display.

Transducer

One or more transducers are included.

The basic EQ60 configuration accepts one or two transducers.
Only two alternatives are available: 38/200 or 50/200. If
additional transducers, or other frequencies, are required, a
General Purpose Transceiver (GPT) must be implemented.

A single frequency General Purpose Transceiver (GPT) accepts
one transducer, and a dual frequency GPT accepts two
transducers.

A large number of transducers are available from Simrad. There
are several transducer alternatives for each operating frequency
with different beam widths, power rating and mounting
arrangements.

All transducers are rated 60 or 75 ohms. Each has an efficiency
of approximately 50%.

Transceiver

The basic EQ60 configuration includes one PC Transceiver
(PCT). It is mechanically integrated with the display unit.
Optional, the high performance and highly flexible General
Purpose Transceiver (GPT) may be added to the system.



Installation

123857-164342 / Rev.C

PC Transceiver

The PC Transceiver comprises a complete dual frequency
single beam system on a computer circuit board. The PCT fits
inside the echo sounder unit, and it is powered directly from the
sounder’s internal power supply. Only one PCT board can be
installed. On a new system, the PC Transceiver is installed and
tested by Simrad prior to delivery. There are no need for the
user to open the echo sounder cabinet.
The PC Transceiver is available in two configurations. Both are
designed for the fishery community:
• PCT-S38(1)/S200(1)-F

- This circuit board contains a single beam 38 kHz 1 kW
channel, and a single beam 200 kHz 1 kW channel.

• PCT-S50(1)/S200(1)-F
- This circuit board contains a single beam 50 kHz 1 kW

channel, and a single beam 200 kHz 1 kW channel.
General Purpose Transceiver

The General Purpose Transceiver (GPT) is a small
self-contained unit containing its own power supply. It operates
from +12 Vdc or 115-230 Vac. The unit can be mounted
anywhere on board the ship, provided that the location is dry
and ventilated. Power cable and mounting brackets are enclosed.
We recommend that the GPT is mounted as close to the
transducer(s) as possible.
The GPT for the EQ60 is only available in single beam
configuration. However, a dual frequency single beam
configuration is provided. Possible operating frequencies are 12,
18, 27, 38, 50, 70, 120 and 200 kHz.
Typical configurations include:
• GPT-S38(4)-F (single beam 38 kHz, 4 kW)
• GPT-S50(4)-F (single beam 50 kHz, 4 kW)
• GPT-S70(1)-F (single beam 70 kHz, 1 kW)
• GPT-S120(1)-F (single beam 120 kHz, 1 kW)
• GPT-S200(1)-F (single beam 200 kHz, 1 kW)
• GPT-S38(1)/S50(1)-F (single beam 38 and 50 kHz, 1+1 kW)
Two or more General Purpose Transceivers (GPT) can exist on
the same Ethernet cable. A multi-frequency sounder emerges
simply by using several transceivers on the Ethernet cable.
It is even possible to combine one internal PC Transceiver with
a number of external General Purpose Transceivers.
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Printer
A printer can be supplied. Most standard off-the-shelf colour
printers can be used. A standard Windows® driver is required.
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General Purpose Transceiver (GPT)

Overview
The GPT transceiver is a self-contained unit. It can be mounted
anywhere onboard the vessel. It is recommended to mount the
GPT as close to the transducer(s) as possible in order to
minimise the electrical interference into the transducer cable.

General Purpose Transceiver

Transducer

DSP-6X IO

+5V
+12V
-12V
HV1
HV2
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(CD5467C / 820-201035/C)

The General Purpose Transceiver is easily mounted with the
brackets supplied with the unit.

Procedure
Two brackets and four pan head screws are enclosed. The side
walls of the unit each hold six screws; three screws along the
bottom edge and three screws along the top edge.
The brackets can be vertically mounted in three different
positions;
• Use the two rear holes, or
• Use the two centre holes, or
• Use the two front holes.
The brackets can be horizontally mounted in four different ways
using either the bottom edge holes or the top edge holes.
1 Unscrew two screws from each side wall.
2 Mount the brackets using the pan head screws.
3 Position the unit on the surface and mark the four

mounting holes.
4 Remove the unit, and drill mounting holes.
5 Mount the unit to the surface using 5 mm bolts.

Related topics
→ Outline drawing, page 193
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Printer

Introduction

Any Microsoft Windows® compatible printer may be connected
to the EQ60 Processor Unit. The connection is made with a
standard Centronics type parallel cable.

Hardware installation

Refer to the applicable printer documentation for hardware
installation. Make sure that the printer is securely mounted to
withstand the shock, vibrations and movements experienced on
a ship.

Software installation

In order to use the printer, you must install the necessary
driver(s) and set up the EQ60 Processor Unit so that the
presence of the printer is known. To do this, you will need to
use the standard Microsoft Windows® tools on the computer.

In this procedure, a Hewlett Packard 970C colour printer is used
as an example.

Note You need to access the underlying operating system directly to
perform this maintenance task. Take care when proceeding. With
full access you can severely damage the operating system if you
are not careful.

1 Terminate the echo sounder program without shutting
down the computer.
- Verify that the echo sounder presents a standard

Microsoft Windows® computer display.
2 Press the Start button in the lower left corner, and activate

the Settings option on the menu.

3 On the Settings sub-menu select Printers.

4 Double-click the Add Printer icon to start the printer
installation software.

5 On the first page, select My Computer. Then, click the
Next button to move to the next page.

6 On the second page, click the check box next to the LPT1
port. Again, click the Next button to move to the next
page.
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7 On the third page, select HP in the manufacturers list, and
HP DeskJet 970C in the printers list. Click Next to
continue.
- If a different printer make is installed, select the

appropriate manufacturer and model. If the printer you
have is not listed, refer to Software installation of
unlisted printer.

8 On the fourth page, the logical name of the printer
becomes HP DeskJet 970C. You can select a different
name by modifying the printer name entry. Make this
printer your default printer by selecting Yes. Click Next to
continue.

9 On the fifth page, select Not Shared. Click Next to
continue.

10 On the sixth page, print a test page. Then, press Finish to
complete the installation.

11 Restart the computer.
Note that menus and dialogues used during printer installation
are part of the operating system. These follow the language
setting of the operating system. They do not comply to the
language setting of the echo sounder program.
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Software installation of unlisted printer
To install additional printers to you echo sounder, contact your
nearest Simrad dealer.
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CABLE LAYOUT

Introduction
This chapter describes the general installation requirements for
the EQ60 system cables. These instructions must be used
together with the applicable cable plan(s).

Note All cable connections and installation must be made in
accordance with the guidelines laid down by the vessel’s
classification society.
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Figure 6 EQ60 cable plan - basic confguration
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Figure 7 EQ60 cable plan - confguration with a
single General Purpose Transceiver (GPT)
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Cable specifications
The cables identified in the cable plan are listed here. Each
cable is identfied with a cable number and a type number.

Basic configuration

ID Type Specifications Use MFD

C1 W103 Page 142 / Note 1 Serial line 1, connects to 9---pin D---sub

C2 W103 Page 142 / Note 1 Serial line 2, connects to 9---pin D---sub

C3 W505 Page 148 Standard Centronics printer cable

C4 W301 Page 144 AC power Yes

C5 W620c Page 152 / Note 2 Heave & temperature sensors

C6 W620b Page 151 / Note 2 External synchronization

C7 W806 Page 161 Transducer(s) Yes

C8 W311 Page 143 Ship’s ground

C9 W511 Page 149 / Note 3 Mouse Yes

C10 W511 Page 149 / Note 3 Keyboard Option

Note 1 - The number of serial lines depends on how many
communication ports that are installed.
Note 2 - These interfaces are both connected to the Auxiliary
plug on the echo sounder unit.
Note 3 - The rollerball and the keyboard shares the same PS/2
connector on the echo sounder by means of an adapter. The
adapter is a part of the system delivery.
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Single GPT configuration
The following additional cables are used if an optional General
Purpose Transceiver (GPT) is used.

ID Type Specifications Use MFD

C20 W620b Page 151 / Note 1 External syncronization

C21 W620c Page 152 / Note 1 Heave & temperature sensors

C22 W620a Page 150 / Note 2 Remote on/off

C23 W319 Page 145 +12 Vdc

C24 W301 Page 144 AC Power Yes

C25 W311 Page 143 Ship’s ground

C26 W802 Page 153 Transducer(s) Yes

C27 W400 Page 146 Ethernet

Note 1 - This connection is not required if it has been made on
the echo sounde unit.
Note 3 - The remote on/off will only switch off the GPT, and
not the echo sounder unit.

Serial port 2 (Com 2)
(9-pin D-connector, male)

Parallel port
(25-pin D-connector, female)

Auxiliary
(25-pin D-connector, female)

Transducer(s)
(9-pin D-connector, female)

Serial port 1 (Com1)
(9-pin D-connector, male)

VGA (External Monitor)
(15-pin D-connector, female)

Ethernet
PS/2

PC Transceiver board

Interface board

Single Board Computer
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Figure 8 Echo sounder’s
side panel with connectors
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External interfaces

Overview
The echo sounder provides one or more multi purpose RS-232
ports (9-pin male D-connector) for external interfacing. On the
Simrad EQ60, these are used for:
• Navigation (GPS) interface (NMEA)
• Annotation text input (NMEA)
• Depth telegram output (NMEA)
• Heave sensor input
• Post-processing data (ethernet interface)
• ITI (Integrated Trawl Instrumentation) communication
• Purse seine
• Temperature sensor input
An analogue heave sensor and a temperature sensing thermistor
may be connected directly to the Auxiliary connector on the
echo sounder. If an optional General Purpose Transceiver (GPT)
is used on the same system, the sensors must be connected to
either the echo sounder or the GPT.
A colour printer may be connected to the printer port (25-pin
female D-connector) at the side of the echo sounder.

Navigation (GPS)
GPS (Global Positioning System) receivers output NMEA 0183
telegrams containing geographical latitude and longitude. The
defined communication parameters are:
• 4800 bits per second
• 8 data bits
• no parity
• one stop bit
Most navigation receivers also allow different parameters to be
entered.
Connect the navigation receiver to a free RS-232 port. Only the
signal (Rx, pin 2) and ground wires (pin 5) need to be
connected. Connect only the signal wire (Tx, pin 3) and the
ground wire (pin 5) to the GPS system’s output. Maximum
cable length is approximately 50 meters.
The connection must be established in the software as well.
Observe the following procedure:
1 Open the Navigation Interface dialogue box.
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2 Enter the name of the selected RS-232 port and the
communication parameters.

Annotation
Annotation messages may be input on the same serial line as the
navigation system. The $??ATS format is used, and it has the
following format..
$??ATS,this is a test<CR><LF>
The telegram header consists of:
1 the $ character
2 two letters ?? (disregarded by the echo sounder, identifies

the sender of the telegram)
3 three letters ATS (Annotation Text String - identifies the

type of NMEA telegram).
4 a comma (NMEA separation character).
5 Text string (The echo sounder handles the string as an

ordinary text. You can not use commas in the text string!)
6 A carriage-return and line-feed pair completes the

telegram.
The ASCII telegram with the external annotation must be
connected to the same serial line as the navigation system.

Depth output
The current depth from a defined transceiver channel can be
sent out on a chosen serial line. One or more of the following
serial lines can be used:
• Heave Sensor
• Navigation Interface
• Trawl Interface
The dialogue boxes used to control these interfaces also include
a button to open the Depth Output dialogue box. From this
dialogue, you can select from three different types of NMEA
depth telegrams.
• The $SDDBS telegram contains the depth below the surface.
• The $SDDBT telegram contains the depth below the

transducer.
• The $SDDPT telegram contains the depth below the

transducer and the distance between the transducer and the
waterline.
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The EQ60 can also output the EA 500/EK500 compatible depth
telegrams; D1, D2 etc. Output for Atlas echo sounders are also
provided.
Only one telegram type at a time can be generated, and the same
serial line parameters as for the main sensor must be used.

Trawl system
Communication with the Simrad ITI (Integrated Trawl
Instrumentation) is based on NMEA telegrams.
Connect the ITI to a free RS-232 port. Only the receive signal
wire (Rx, pin 2), the transmit signal wire (Tx, pin 3) and the
ground wire (pin 5) need to be connected.
Maximum cable length is approximately 50 meters.
The connection must be established in the software as well.
Observe the following procedure:
1 Open the Trawl Interface dialogue box.
2 Enter the name of the selected port.
3 Enter the following communication parameters: 4800 bits

per second, 8 data bits, no parity, one stop bit.

Post-processing data
The EQ60 can communicate with an external post-processing
chart plotter system using the ethernet interface. This
communication is controlled by the BI500 dialogue box.
The following telegrams may be used:
• Parameter
• Echogram
• Echo Trace
• Navigation
• Vessel Log
The interface will require the absolute identity of the remote
UDP port and the remote IP address.

Heave sensor
A heave sensor with an analogue output is connected directly to
the Auxiliary connector.
The positive heave input signal (pin 3) is connected to the
sensor output terminal. The negative heave input signal (pin 16)
is grounded at the sensor in order to prevent ground potential
offsets between the sensor and the transceiver from adding to
the sensed signal.
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Maximum cable length is virtually unlimited.
The connection must be established in the software as well.
Observe the following procedure:
1 Open the Heave Sensor dialogue box.
2 Select the appropriate transceiver.
Heave sensors with a serial line output are connected to a free
RS-232 port at the rear of the computer. Maximum cable length
is approximately 50 meters. In these cases, use the Heave
Sensor dialogue box to enter the required communication
parameters and the name of the selected port.

Temperature sensor
Connect the temperature sensing thermistor to the Auxiliary
connector (pins 4 and pin 17).
Observe that pins 2 and 4 of the PC Transceiver’s Transducer
connector are internally interconnected with pins 4 and 17 of the
Auxiliary connector.

Purse seine
Communication with the Simrad PI30 (Purse Seine system) is
based on NMEA telegrams.
Connect the PI30 to a free RS-232 port at the rear of the
computer. Only the receive signal wire (Rx, pin 2), the transmit
signal wire (Tx, pin 3) and the ground wire (pin 5) need to be
connected. Maximum cable length is approximately 50 meters.
The connection must be established in the software as well.
Observe the following procedure:
1 Open the Purse Seine dialogue box.
2 Enter the name of the selected port.

3 Enter the following communication parameters: 4800 bits
per second, 8 data bits, no parity, one stop bit.

Colour printer
Connect the printer to the parallel port, use a standard printer
cable with all wires connected. Maximum cable length for
parallel cable is approximately 10 meters.
The connection must be established in the software as well.
Observe the following procedure:
1 Open the Printer Setup dialogue box.
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2 Enter the selected printer.

Ethernet connections
An ethernet RJ45 cable is used to connect the Processor Unit to
the General Purpose Transceiver, (GPT). The same type of cable
is used between the optional HUB and external devices.
Note that the cable required is not a part of the delivery.
However, four RJ45 plugs are provided.
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External triggering

Overview
Whenever more than one hydroacoustic system (echo sounder or
sonar) is installed on a vessel, interference may occur. To avoid
this, the systems may either be connected to a common
synchronization system, or one of the acoustic systems may be
defined as a “master”.
The EQ60 echo sounder include interface for remote transmit
synchronisation. The system can be set up to operate in either
Master or Slave mode in relation to an external synchronization
or hydroacoustic system.
The EQ60 system may comprise more than one General Purpose
Transceiver (GPT). If the EQ60 operates as a Master, the
synchronization between these are controlled by the echo
sounder software. If the echo sounder operates as a Slave
system, the GPT units must be individually controlled by the
Master system.

Note In its default configuration, the EQ60 is set up to operate as a
Master. Special action must be taken to reconfigure the echo
sounder for Slave operation.

Master system
When the EQ60 system is set up to operate as a Master in a
system, the TrigOut signal from the GPT Auxiliary connector
must be connected to the external trigger input on the other
hydroacoustic system(s). If more than one GPT us used by the
Master system, the TrigOut signal must be taken from the
active GPT. Two TrigOut signals are available for either
positive or negative triggering. When activated. the trigger
signal will allow all the systems to transmit simultaneously.

Note Simultaneous transmission of more than one system can only
take place if the systems operate with different frequencies!

→ The cable and connections to the GPT is shown on page 151.
The TrigOut+ signal is an open collector output (max 100 mA)
containing a 100-kohm pullup resistor to +5 Vdc. This signal is
normally low. The TrigOut+ signal goes high when the
transceiver is ready to transmit, and it goes low again when all
frequency channels of the transceiver have finished transmitting.
TrigOut- is the inverse of TrigOut+.
Connect the ground wire to one of the Ground pins (18-22).
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Slave system
If an external system is used to provide the transmit trigger, the
trigger signal must be connected to one of the TrigIn inputs on
the GPT Auxiliary connector. When activated. the trigger signal
from the external system will allow the EQ60 system to
transmit.
If more than one GPT is used by the Slave system, the input
trigger must be connected to all the GPT units in parallel.
Two TrigIn inputs are available for either positive or negative
triggering. The TrigIn- input is sensitive to a high-to-low
transition.
Connect the ground wire to one of the Ground pins (18-22).

Note If the EQ60 system comprises more than one GPT unit, the
external trigger must be connected in parallel to every GPT.

→ The cable and connections to the GPT is shown on page 151.
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Cable terminations
Refer to the referenced specific cable drawings on the following
pages for more detailed information about each cable.



Simrad EQ60

142 857-164342 / Rev.C

Generic RS-232 Serial line
This cable comprises a multi-purpose serial line. It provides
interface with any peripheral unit. One end of the cable connects
to the local unit (DTE) with a 9-pin ’D’ connector, while the
other connects to the peripheral (DCE) as described in the
peripheral unit’s documentation.
Note that this cable does not support all the signals in the
standard RS-232 specification.

W103 / Rev G Standard RS-232 serial line

2
3
5

Rx
Tx

Ground

View

Local (DTE) 9-pin
‘D’ connector

Remote unit (DCE) to
be connected as described
in applicable documentation

Looking into
female 9-pin

D-pin connector

5 1

69

Looking into
male 9-pin

D-pin connector

1 5

96

Screen

To plug housing

Conductors 3 x 2 x 0.5 mm2

Screen Overall braided

Voltage 60V

Max.diameter Set by the plugs
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EMC ground
This cable is used to connect the system unit to the ship’s
ground.
Note that this cable must be as short as possible.

W311 / Rev B Ship's ground

Units's ground tag
Ships' ground

Conductors 1 x 6 mm2

Screen None

Voltage 60 V

Max.diameter N/A
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Standard AC power cable
This cable is a standard three-wire power cable. It is
commercially available in standard lengths, or may be produced
locally to suit the specific installation needs. The instrument end
is terminated in a standard IEC female socket, while the other
end is terminated in a plug suitable for the local standard.

W301 / Rev B Standard power cable for 115/230 Vac 2-phase

Live (normally Blue)

Neutral (normally Brown)

Use the applicable plug to suit
local standard. British standard
plug used as example only.

Ground (always Yellow or Yellow/Green)

IEC plug

Note Different cable colours may be used for the “live” and
“neutral” wires. Ground is however always on green/yellow.

Conductors 2 x 1.5 mm2 + GND

Screen None

Voltage 750 V

Max. diameter Set by the plugs
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Battery
This cable is used to connect a battery to the system. Red plug
and red socket is normally used for positive (+). Black plug and
black socket is normally used for negative (-).

W319 / Rev. A Battery

Banana plugs
and sockets

Battery

+

Conductors 2 x 1.5 mm2

Screen None

Voltage Selected to fit the battery voltage and the
expected current

Max.diameter N/A
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Ethernet with RJ45
This cable contains the Ethernet connection. RJ45 plugs are
used to terminate the cable. Note that these plugs must be
screened to comply to EC rules.

W400 / Rev E Ethernet 10Base-T with RJ45 plugs

Pairs

Pairs

1

1

3

3

2

2

4

4

5

5

7

7

6

6

8

8

1

1

3

3

2

2

4

4

5

5

7

7

6

6

8

8

RJ45 plug

RJ45 plug

RJ45 plug

Ethernet 10Base-T “Straight Through”

Ethernet 10Base-T “Crossover”
The “crossover” cable is used to cascade HUBs, 
or for connecting two ethernet stations or 
computers back-to-back without a HUB)

NOTE: In order to prevent noise and crossover, 
you are strongly adviced to use the cable pairs 
indicated above.

TX Data + (White/Orange)

(1) TX Data + to (3) Recv Data +

Tx Data - (Orange)

(2) Tx Data - to (6) Recv Data -

Recv Data + (White/Green)

(3) Recv Data + to (1) Tx Data +

(Blue)

(White/Blue)

Recv Data - (Green)

(6) Recv Data - to (2) Tx Data -

(White/Brown)

(Brown)

RJ45 plug

Pin 8

Pin 8

View

Pin 1

Pin 1
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Ethernet with IEEE 802.3
This is a standard ethernet connection. It complies to IEEE
802.3.

W404 / Rev B Ethernet (IEEE 802.3)

1
2
3
5
6
9

10
12
13

Ethernet
socket

Remote
system

Collision presence (-)

Transmit (+)

Transmit (-)

Screen

Receive (+)

Receive (-)
+15 Vdc

Collision presence (+)

0 Vdc

Connect to connector housing15-pin
D-pin connector

Female 15-pin
D-pin connector

Male 15-pin
D-pin connector

1 8

159

8 1

915

View

Conductors 6 x 0.5 mm2

Screen Overall braided

Voltage 60 V

Max.diameter Limited by the plugs



Simrad EQ60

148 857-164342 / Rev.C

Centronics printer cable
This is a standard Centronics printer cable.

W505 / Rev C Centronics printer cable

1

3
2

4
5

7
6

8
9

11
10

15
18-
24

Strobe
Data 0
Data 1
Data 2
Data 3
Data 4
Data 5
Data 6
Data 7
Acknowledge
Busy
Error
Ground

Printer
plug

25-pin
D-connector

25 14

113The socket on the rear
side of the computer
is normally a 25-pin female
D-connector.
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Keyboard and rollerball
The mouse and the display are both equipped with standard
PS/2 connectors. An adapter is used to fit both simultanously
into one socket. The adpater must be used at all times, even
when the keyboard is disconnected.

W511Revision: A Keyboard and rollerball

Keyboard

Rollerball, mouse or
other pointing device

Adapter
cable

PS/2
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Remote on/off
This cable is used to connect a remote on/off switch to the
General Purpose Transceiver (GPT). The switch can be located
in a separate box, or incorporated on a common switch panel.

W620a / Rev C Remote on/off

23

GPT
25-pin D-sub connector

22

Reset and
Remote on/off

The cable screen is connected
to the plug house.

SIMRAD GPT

25

14 1

13

Auxiliary
connector
(female)

223
122

The cable screen is connected
to the plug house.

Remote connector on
HOS 151 and HOS 181

GPT
25-pin D-sub connector

Conductors 2 x 0.22 mm2

Screen Overall braided

Voltage 60 V

Max.diameter Set by the plugs
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GPT Remote synchronisation
This cable is used to connect the General Purpose Transceiver
(GPT) to an external system for synchronisation purposes.

W620b / Rev C External trigger in/out

25

GPT
25-pin D-sub connector

24

13
12 TrigOut(+)

TrigOut(-)

TrigIn(+)

TrigIn(-) Several transceivers may be
triggered from an external system by
connecting the TrigIn pins in parallel.

SIMRAD GPT

25

14 1

13

Auxiliary
connector
(female)

The cable screen is connected
to the plug house.

Conductors 2 x 2 x 0.22 mm2

Screen Braided pairs and overall braided

Voltage 60 V

Max.diameter Set by the plugs
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Heave and Temperature sensors
This cable is used to connect the General Purpose Transceiver
(GPT) to external Heave and Temperature sensors.

W620c / Rev C Heave, Roll, Pitch and Temperature sensors

17

GPT 25-pin D-sub connector

4

2
1 Pitch(+)

Temp(+)

Roll(+)

Temp(AGND)

SIMRAD GPT

25

14 1

13

Auxiliary
connector
(female)

The cable screen is connected
to the plug house.

Heave(+)
Pitch(-)
Roll(-)

Heave(-)

3
14
15
16

Conductors 2 x 0.22 mm2

Screen Overall braided

Voltage 60 V

Max.diameter Set by the plugs
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Transducer(s)
The cables described in this chapter are used to connect the
General Purpose Transceiver (GPT) to one or more transducers.
The following transducer types may be used:
• Single frequency, single beam
• Single frequency, dual beam (wide and narrow)
• Dual frequency, single beam (combi)
→ The plug housing is shown on page 160.

For the majority of the transducers, the cables are supplied from
the manufacturer. These are normally physically fastened to the
transducer.
If the distance between the transducer and the transceiver
exceeds the length of the cable, a junction box must be used.
The cable between the junction box and the transceiver must
then be supplied by Simrad, and this must be the same type as
used on the transducer(s).

Note All transducer cables must be run in steel conduits. Use flexible
conduit close to the transceiver.

Note Cable shields must be connected to the plug housing. The
shields must not be connected to ship’s ground anywhere
between the transducer and the plug on the transceiver.

→ The termination of the cable shielding is shown on page 160.

Observe the cabling diagrams.
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Single frequency, single beam

The next two drawings show how to connect a single frequency,
single beam transducer to the system. Note that two different
connections are made, depending on the rated power output.
Low power output is achieved when the GPT is equipped with a
single transmitter board. In most systems, this will result in a 2
kW output power, but older GPTs may only be capable of
supplying 1 kW.

M

E F JH

D

C

K

L

A
B

N

W802-1 / Rev.D Single frequency, single beam, low power

Single frequency,
single beam
transducer.

C
D

GPT

Note:
1) All transducer cables must be run in
steel conduits. Use flexible conduit closer
to the transceiver.
2) Cable shields must be connected to
the plug housing.
3) Cable shields must  be connected to
ship's ground in the junction box.

not

Inner
screen

Plug housing

Outer
screen

Junction Box (1:1)

Conductors 2 x N mm2

Screen Overall braided

Voltage 600 V

Max.diameter N/A

The conductor diameter “N” depends on the chosen transducer.
Normal value for single beam transducers is 1.5 mm2. Special
transducer cable is available from Simrad.
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High power output is achieved when the GPT is equipped with
four transmitter boards. In most systems, this will result in a 4
kW output power, but older GPTs may only be capable of
supplying 2 kW.

M

E F JH

D

C

K

L

A
B

N

W802-6 / Rev.A Single frequency, single beam, high power

Single frequency,
single beam
transducer.

E

A

H

C

J

D

F

B

GPT

Note:
1) All transducer cables must be run in
steel conduits. Use flexible conduit closer
to the transceiver.
2) Cable shields must be connected to
the plug housing.
3) Cable shields must  be connected to
ship's ground in the junction box.

not

Inner
screen

Plug housing

Outer
screen

Junction Box (1:1)

Conductors 2 x N mm2

Screen Overall braided

Voltage 600 V

Max.diameter N/A

The conductor diameter “N” depends on the chosen transducer.
Normal value for single beam transducers is 1.5 mm2. Special
transducer cable is available from Simrad.
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Single frequency, dual beam

The drawing shows how to connect a single frequency, dual
beam transducer to the system.

Note Check the transmit power if wide beam is selected in order not
to exceed the power capacity on the transducer.

M

E F JH

D

C

K

L

A
B

N

W802-2 / Rev B Single frequency, dual beam

Single frequency,
dual beam transducer,
wide

Single frequency,
dual beam transducer,
narrow

C

C

D

D

GPT

GPT

Inner
screen

Inner
screen

Outer
screen

Outer
screen

Junction Box (1:1)

Junction Box (1:1)

Note:
1) All transducer cables must be run in
steel conduits. Use flexible conduit closer
to the transceiver.
2) Cable shields must be connected to
the plug housing.
3) Cable shields must  be connected to
ship's ground in the junction box.

not

Plug housing

Plug housing

Conductors 3 x N mm2 or 2 x N mm2

Screen Overall braided

Voltage 600 V

Max.diameter N/A

The conductor diameter “N” depends on the chosen transducer.
Normal value for single beam transducers is 1.5 mm2. Special
transducer cable is available from Simrad.
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Dual frequency, single beam

The drawing shows how to connect a dual frequency, single
beam transducer to the system.

M

E F JH

D

C

K

L

A
B

N

W802-4 / Rev.C Dual frequency, single beam

Dual frequency,
single beam
transducer

C

H

D

J

GPT

Inner
screen

Outer
screen

Junction Box (1:1)

Low frequency

High frequency

Note:
1) All transducer cables must be run in
steel conduits. Use flexible conduit closer
to the transceiver.
2) Cable shields must be connected to
the plug housing.
3) Cable shields must  be connected to
ship's ground in the junction box.

not

Plug housing

Conductors 2 x 2 x N mm2

Screen Overall braided

Voltage 60 V

Max.diameter N/A

The conductor diameter “N” depends on the chosen transducer.
Normal value for single beam transducers is 1.5 mm2. Special
transducer cable is available from Simrad.
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Split beam transducer connected as single beam

The drawing shows how to connect a split beam transducer to a
single beam system.

W802-5 / Rev.C Split beam transducer connected as single beam

Single frequency, split beam
transducer

C
D

GPT

Junction Box (1:1)

Ch.1
Ch.3
Ch.2

Forward

Aft

StarboardPort
Ch.4

Blue

Blue

Blue

Blue

Black

Black

Black

Black

M

E F JH

D

C

K

L

A
B

N

Inner
screen

Outer
screen

Note:
1) All transducer cables must be run in
steel conduits. Use flexible conduit closer
to the transceiver.
2) Cable shields must be connected to
the plug housing.
3) Cable shields must  be connected to
ship's ground in the junction box.

not

Plug housing

Ch.4

Ch.3

Ch.2

Ch.1

Conductors 4 x 2 x N mm2

Screen Overall braided

Voltage 600 V

Max.diameter N/A

The conductor diameter “N” depends on the chosen transducer.
Normal value for single beam transducers is 1.5 mm2. Special
transducer cable is available from Simrad.
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Cable colours on split beam transducers

Note that the cables from the transducer may be supplied in
different colours. The following colours may be used:

Channel Shown in W802--3 Alt.A Alt B

4 BL BK BN

4 BK WH WH

3 BL BK GN

3 BK WH WH

2 BL BK O

2 BK WH WH

1 BL BK BL

1 BK WH WH
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Rubber sleeve
Rubber sleeve

Retaining ring
Contact body

Plug
fastening ring

Upper plug case

Bottom cap
and cable clamp

Washers

Heat-shrinkable tubing

Lower plug case

Outer screen together with inner screen.
Drain wire, fold back over jacket
and temporary fastened with tape.

Outer screen and inner screen braid wire 
untaped and spread out under washer

(C
D

53
70

A 
/ 8

24
-2

01
57

5/
C

 / 
G

IF
)

Figure 9 GPT Plug connection, transducer
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PC Transceiver to transducer(s)
This cable connects the PC Transceiver board to one or tow
transducers. The cable must be run in steel conduits. Use a
junction box only if required.

W806Revision: A

Two separate, or
one dual frequency
transducer

6

8

2

7

9

4

PCT

Inner
screen

Outer
screen

Pins 1, 3
and 5 are not
connected.

Water temperature sensor
(Only available with Simrad Combi

transducers 38/200 and 50/200.)

Junction Box (1:1)

High frequency

Low frequency

Note:
1) All transducer cables must be run in
steel conduits. Use flexible conduit closer
to the transceiver.
2) Cable shields must be connected to
the plug housing.
3) Cable shields must  be connected to
ship's ground in the junction box.

not

Plug housing

PC Transceiver to transducer(s)

Female 9-pin
D-pin connector

on PCT Board
5

1 6

9

Conductors 2 x N mm2 for each transducer

Screen Overall braided

Voltage 60V

Max. diameter Set by the plugs

The conductor diameter “N” depends on the chosen transducer.
Normal value for single beam transducers is 1.5 mm2. Special
transducer cable is available from Simrad..
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Basic cabling requirements

Cable trays

All permanently installed cables associated with the system
must be supported and protected along their entire lengths using
conduits and/or cable trays. The only exception to this rule is
over the final short distance (max. 0.5 metre) as the cables run
into the cabinets/units to which they are connected. These short
unsupported lengths are to allow the cabinets to move on their
shock mounts, and to allow maintenance and replacements.

• Wherever possible, cable trays must be straight, accessible
and placed so as to avoid possible contamination by
condensation and dripping liquids (oil, etc.). They must be
installed remote from sources of heat, and must be protected
against physical damage. Suitable shields must be provided
where cables are installed in the vicinity of heat sources.

• Unless it is absolutely unavoidable, cables should not be
installed across the vessel’s expansion joints. If the situation
is unavoidable, a loop of cable having a length proportional
to the possible expansion of the joint must be provided. The
minimum internal radius of the loop must be at least twelve
times the external diameter of the cable.

• Where a service requires duplicate supply lines, the cables
must follow separate paths through the vessel whenever
possible.

• Signal cables must not be installed in the same cable tray or
conduit as high-power cables.

• Cables containing insulation materials with different
maximum-rated conductor temperatures should not be
bunched together (that is, in a common clip, gland, conduit or
duct). When this is impractical, the cables must be carefully
bunched such that the maximum temperature expected in any
cable in the bunch is within the specifications of the
lowest-rated cable.

• Cables with protective coverings which may damage other
cables should not be bunched together with other cables.

• Cables having a copper sheath or braiding must be installed
in such a way that galvanic corrosion by contact with other
metals is prevented.

• To allow for future expansion of the system, all cables should
be allocated spare conductor pairs. Also, space within the
vessel should be set aside for the installation of extra cables.
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Radio Frequency interference

All cables that are to be permanently installed within 9 m
(30 ft) of any source of Radio Frequency (RF) interference such
as a transmitter aerial system or radio cabin, must, unless
shielded by a metal deck or bulkhead, be adequately screened by
sheathing, braiding or other suitable material. In such a situation
flexible cables should be screened wherever possible.
It is important that cables, other than those supplying services to
the equipment installed in a radio room, are not installed
through a radio room. Cables which must pass through a radio
room must be screened by a continuous metal conduit or
trunking which must be bonded to the screening of the radio
room at its points of entry and exit.

Physical protection

Cables exposed to the risk of physical damage must be enclosed
in a steel conduit or protected by a metal casing unless the
cable’s covering (e.g. armour or sheath) is sufficient to protect it
from the damage risk.
Cables exposed to an exceptional risk of mechanical damage
(for example in holds, storage-spaces and cargo-spaces) must be
protected by a suitable casing or conduit, even when armoured,
if the cable covering does not guarantee sufficient protection for
the cables.
Metallic materials used for the physical protection of cables
must be suitably protected against corrosion.

Grounding

All metallic cable coverings (armour, lead sheath etc.) must be
electrically connected to the vessel’s hull at both ends except in
the case of final sub-circuits where they should be connected at
the supply end only.
Grounding connections should be made using a conductor which
has a cross-sectional area related to the current rating of the
cable, or with a metal clamp which grips the metallic covering
of the cable and is bonded to the hull of the vessel. These cable
coverings may also be grounded by means of glands specially
intended for this purpose and designed to ensure a good earth
connection. The glands used must be firmly attached to, and in
good electrical contact with, a metal structure grounded in
accordance with these recommendations.
Electrical continuity must be ensured along the entire length of
all cable coverings, particularly at joints and tappings. In no case
should the lead-sheathing of cables be used as the only means of
grounding cables or units.
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Metallic casings, pipes and conduits must be grounded, and
when fitted with joints these must be mechanically and
electrically grounded.

Cable connections

All cable connections are shown on the applicable cable plan
and interconnection diagrams.
Where the cable plan shows cable connections outside an
equipment box outline, the connections are to be made to a plug
or socket which suits the plug or socket on that particular item
of equipment.
Where two cables are connected in series via a junction box or
terminal block, the screens of both cables must be connected
together but not grounded.

Cable terminations

Care must be taken to ensure that the correct terminations are
used for all cable conductors, especially those that are to be
connected to terminal blocks. In this case, crimped
sleeve-terminations must be fitted to prevent the conductor core
from fraying and making a bad connection with the terminal
block. It is also of the utmost importance that where crimped
terminations are used, the correct size of crimp and crimping
tool are used. In addition, each cable conductor must have a
minimum of 15 cm slack (service loop) left before its
termination is fitted.

Cable identification

Cable identification codes corresponding to the cable number
shown in the cable plan must be attached to each of the external
cables. These identification codes should be positioned on the
cable in such a way that they are readily visible after all panels
have been fitted. In addition, each cable conductor should be
marked with the terminal board number or socket to which it is
connected.
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Cable gland assembly procedure

Purpose
Cable glands are used whenever a cable passes through a
water-tight bulkhead or into a cabinet, to seal the opening
through which the cable passes and to protect the cable from
abrasion on the edges of the hole. Follow the guidelines detailed
here when installing cables through cable glands.

Note There are many different types of cable gland on the market.
This procedure describes the types used (now and previously) as
standard in the units manufactured by Simrad. The cable glands
are not supplied with the system.

Even though the cabinets from Simrad may be prepared for
specific types, the installation shipyard will be responsible for
selecting cable gland types and installing them.

Note The screen in transducer cables must never be connected to
ship’s ground in the cable glands!

General procedure
1 Ensure all the cables to be connected are completely

isolated from any power sources.
- I.e. Switch off and remove the supply fuses from any

units or systems into which the cables are already
connected.

2 Select the cable to be connected into the cabinet, and
select the cable gland through which the cable is to pass.

Note A minimum of 5 cm (recommended 5 - 10 cm) of slack cable
must be allowed, both inside and outside the cabinet, when
installing cables. This is to allow for vibration damping,
maintenance and measurement errors. Always double-check
your measurements before taking any irreversible actions.

3 Depending on whether the cable has already been installed
in conduits, either.
f (installed) measure the maximum length of cable

required to reach from the final cable clip outside the
cabinet to the terminal blocks inside the cabinet, add 20
cm, then remove the excess cable,

or:
g (loose cable) measure the maximum length of wire

required to reach from the cable gland to the terminal
blocks inside the cabinet, add 20 cm. and mark the
cable.
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Note The cable’s outer insulation will extend into the cable gland to a
point approximately 5 mm outside the outer surface of the
cabinet wall into which the cable gland is secured.
4 Taking care not to damage the screening, carefully remove

the outer insulation from the required cable length.
5 Leaving an appropriate length of the screen exposed from

the insulation, cut off the remainder.

Securing and terminating the cables
1 Referring to the wiring diagram and ensuring that there is

5 to 10 cm. slack cable inside the cabinet, prepare and
connect the cable cores to the appropriate terminals within
the cabinet.

2 Secure the cable within the cabinet using cable clips.
3 Check the terminal connections against the wiring diagram

to ensure they are correct.
Follow the same procedure for all the cables and cable glands.
Once all the cables have been fitted:
4 Check the cabinet to ensure all tools and rubbish are

removed, then close the cabinet door.
Once all the system cables are connected and checked:
5 Take the appropriate safety measures, then replace the

fuses and apply power to the system.
6 Perform a system test to ensure the installation has been

conducted successfully.

Multi-diameter modules
Multi-diameter cable glands are now available from several
sources, and these types are becoming increasingly popular due
to ease of use. Only a brief description of the system will be
presented her, further information with technical specifications
and installation descriptions must be obtained from the
manufacturer(s).

The illustrations and examples here are from the following
manufacturer:
Roxtec AB
Bx 540
S-371 23 Karlskrona, SWEDEN
http://www.roxtec.se

To use this sealing system, you first need to cut an opening in
the wall (bulkhead, cabinet etc) you wish to penetrate, and this
hole must be sized to fit one of the standard rectangular or
circular frames provided by the manufacturer.
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Figure 10 Multi-diameter
modules (example)

After the frame has been mounted, the cables can be pulled
through, and in most cases the opening will be large enough
even to accept the plugs on the cables.

Figure 11 Multi-diameter
system - Principal procedure

Once the cables are through, each cable is secured with a square
module, which is adjusted to fit the cable’s outer diameter.
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When the required number of modules are installed, the
assembly is tightened with a compression unit.

This system is available with a large number of various modules
and compression units, and it will also comply to screening and
EMC requirements.

Figure 12 Multi-diameter
system - The finishied

assembly

Standard type

1 Ensure that all the cables to be connected, are completely
isolated from any power sources.
- Switch off and remove the supply fuses from any units

or systems into which the cables are already connected.

2 Select the cable to be connected into the cabinet, and
select the cable gland through which the cable is to pass.

3 Slacken and remove the compression nut from the cable
gland, and extract the compression seal and the screen
collar from the body of the gland.

Note A minimum of 5 cm (recommended 5 - 10 cm) of slack cable
must be allowed, both inside and outside the cabinet, when
installing cables. This is to allow for vibration damping,
maintenance and measurement errors. Always double-check
your measurements before taking any irreversible actions.
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Figure 13 Standard
cable gland assembly

Compression nut

Cable

Gland body Cabinet panel

Screen collarCompression seal

Screen

(CD3260)

4 Depending on whether the cable has already been installed
in conduits, either:
h (installed) measure the maximum length of cable

required to reach from the final cable clip outside the
cabinet to the terminal blocks inside the cabinet, add 20
cm, then remove the excess cable,

or:
i (loose cable) measure the maximum length of wire

required to reach from the cable gland to the terminal
blocks inside the cabinet, add 20 cm. and mark the
cable.

Note The cable’s outer insulation will extend into the cable gland to a
point approximately 5 mm outside the outer surface of the
cabinet wall into which the cable gland is secured.

5 Taking care not to damage the screening, carefully remove
the outer insulation from the required cable length.

6 Leaving 12 mm of the screen exposed from the insulation,
cut off the remainder.

7 Taking care not to damage the screening, slide the
compression nut (smallest diameter first) over the cable
and onto the intact insulation.

8 Taking care not to damage the screening, slide the
compression seal (rounded end first) over the cable and
onto the intact insulation.

9 Slide the screen collar (narrow end first) onto the cable
and fit it underneath the screen. Slide it as close to the
intact outer insulation as possible.

10 If the screen extends beyond the “flat” end of the screen
collar, fold any excess length over the end of the collar
such that the screen will be gripped between the collar and
the gland body when the parts are assembled.
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11 Carefully thread the cable through the gland body till the
screen collar is tight into the gland body.

12 Slide the compression seal into the gland body till the
shoulder is hard up against the gland body.

13 Slide the compression nut over the compression seal and
engage the threads.

14 While holding the gland body to prevent it turning, and
pressing the cable into the gland, tighten the compression
nut onto the gland body.

15 Referring to the wiring diagram and ensuring that there is
5 to 10 cm. slack cable inside the cabinet, prepare and
connect the cable cores to the appropriate terminals within
the cabinet.

16 Secure the cable within the cabinet using cable clips.
17 Check the terminal connections against the wiring diagram

to ensure they are correct.
Follow the same procedure for all the cables and cable glands.
Once all the cables have been fitted:
18 Check the cabinet to ensure all tools and rubbish are

removed, then close the cabinet door.
Once all the system cables are connected and checked:
19 Take the appropriate safety measures, then replace the

fuses and apply power to the system.
20 Perform a system test to ensure the installation has been

conducted successfully.

Additional type 1 (842-093878)
1 Mount the cable gland body, and tighten it with the nuts

on each side of the cabinet wall.
2 Slide the metal washers, the rubber gasket and the

compression nut onto the cable in the order indicated in
the figure.

→ Refer to figure 14.

3 Bend the screen over the rubber gasket.
4 Push the rubber gasket and the two metal washers

carefully into the cable gland body.
5 While holding the gland body to prevent it turning, and

pressing the cable into the gland, tighten the compression
nut onto the gland body.
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Rubber gasket

Metal washer

Cable gland body

Compression nut

Cabinet wall

Inner cable

Outer screen bend backwards
over the rubber gasket

Cable

Metal washer

(CD3685/093878)

Figure 14 Cable gland, type 1 (842-093878)

Additional type 2 (541-093642)
1 Mount the cable gland body, and tighten it with the nuts

on each side of the cabinet wall.
2 Slide the metal washers, the rubber gasket and the

compression nut onto the cable in the order indicated in
the figure.

→ Refer to figure 15.

3 Bend the screen over the compression cone.
4 Push the compression conne, the washers and the rubber

sealing washer into the cable gland body.
5 Close the mounting nut.
6 Close and tighten the compression nut on the other side of

the cabinet wall.
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(CD3765/093642)  

Compression cone Rubber sealing

Metal washersFemale compression cone

Compression nut

Mounting nut

Cable gland body

Figure 15 Cable
gland, type 2
(541-093642)
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TRANSDUCER INSTALLATION

Transducer location

General
A single answer to the question where to locate the transducer
cannot be given. It depends very much on the vessel’s
construction. However, there are some important guide lines.

Go deep
The upper water layers of the sea contain a myriad of small air
bubbles created by the breaking waves. In heavy seas the
uppermost 5 to 10 metres may be air-filled, with the highest
concentrations near the surface. Air bubbles absorb and reflect
the sound energy, and may in worst cases block the sound
transmission totally. Therefore, mount the transducer at a deep
position on the hull.
Consider the situation when the vessel is unloaded, and when it
is pitching in heavy seas. The transducer must never be lifted
free of the water surface. Not only will the sound transmission
be blocked, but the transducer may be damaged by slamming
against the sea surface.
Another reason to go deep is cavitation in front of high power
transducers. Cavitation is the formation of small bubbles in the
water due to the resulting local pressure becoming negative
during parts of the acoustic pressure cycles. The cavitation
threshold increases with the hydrostatic pressure.

Boundary water layer
When the vessel forces its way through the sea, the friction
between the hull and the water creates a boundary layer. The
thickness of the boundary layer depends upon vessel speed and
the roughness of the hull. Objects protruding from the hull, and
dents in the hull, disturb the flow and increase the thickness of
the boundary layer. The flow in this boundary layer may be
laminar or turbulent. A laminar flow is a nicely ordered, parallel
movement of the water. A turbulent flow has a disorderly
pattern, full of eddies. The boundary layer increases in thickness
when the flow goes from laminar to turbulent. Figure 16 (next
page) sketches the boundary layer of a vessel moving through
the water.
Furthermore, air bubbles in the sea water are pressed down
below the hull and mixed into the boundary layer. The boundary
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layer is thin underneath the forward part of the vessel, and
increases in thickness as it moves towards aft. If the sides of the
hull are steep, some of the air bubbles in the boundary layer may
escape to the sea surface along the vessel sides. It is our
experience that a wide and flat bottom, with a rising angle less
than around 13 degrees, is prone to giving air problems for the
transducer. In any case a transducer location in the forward part
of the hull is preferred in order to minimise the influence of the
boundary layer.

Figure 16 Sketch of the boundary layer underneath the vessel.
(CD3002)

Turbulent flow Laminar flow Aerated water

Propeller noise
The propulsion propeller is the dominant noise source on most
fishing vessels, research vessels, merchant vessels and pleasure
crafts. The noise is transmitted through the sea water. Therefore
the transducer should be placed far away from the propeller,
which means on the fore part of the hull. Positions outside the
direct line of sight from the propeller are favourable. On small
vessels with short distances it is advised to mount the transducer
on that side of the keel where the propeller blades move
upwards, because the propeller cavitation is strongest on the
other side. The cavitation starts most easily when the water
flows in the same direction as the propeller blade, and that is to
some degree the case at that side of the keel where the propeller
blades move downwards.
Bow thruster propellers are awful machines. When they are in
operation, the noise and cavitation bubbles make the echo
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sounder useless, almost no matter where the transducer is
installed. And when not in operation, the tunnel creates
turbulence, and if the vessel is pitching, the tunnel may be filled
with air or aerated water in the upper position and release this in
the lower position. Therefore, an echo sounder transducer
should be placed well away from the bow thruster.

Vessel heave

Heave is the up and down movement of the vessel. It disturbs
the echo traces in the echogram, so that a flat bottom is
displayed as a wave. A transducer location in the middle of the
vessel minimises the influence of vessel roll and pitch.

Noises from protruding objects on the hull

Objects protruding from the hull, such as zinc anodes, sonar
transducers or even the vessel’s keel, generate turbulence and
flow noise. Also holes and pipe outlets are noise sources. They
may act as resonant cavities amplifying the flow noise at certain
frequencies. Do not place an echo sounder transducer in the
vicinity of such objects, and especially not close behind them.

Figure 17 Recommended location of the transducer on the
hull

(CD1997C)

L

Max 1/3 L

Approximately 3 degrees tilt
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Summary
Some of the above guide lines are conflicting, and each case has
to be treated individually in order to find the best compromise.
Generally the propeller noise is the dominant factor, and a
recommended transducer location is in the fore part of the hull,
with maximum distance from the bow equal to one third of the
total length of the hull at the water line.
→ See figure 17.

If the vessel hull has a bulbous bow, this may well be a good
transducer location, but also here must be taken into
consideration the flow pattern of the aerated water. Often the
foremost part of the bulb is preferable.
→ See figure 18.

Figure 18 Transducer location on a bulbous bow
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Thruster
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Ways of mounting the transducer

Inclination of the transducer face
Incline the transducer face approximately 3 degrees, so that the
flowing water meets it directly. This assures laminar water flow.
Mounting screws should not be extruding from the transducer,
and the space around the screws could be filled with a
compound or a locking ring.
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External mount
Some transducers have a streamlined housing, designed for
installation outside the hull.

Figure 19 External mounting on steel hulls
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3°

Bedding
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A fairing, made by the shipyard, is placed between the
transducer and the hull, to adapt for the deadrise angle of the
hull. The fairing can be made of wood or steel, and should have
the same outline dimensions as the transducer. These
transducers are mainly used on smaller vessels. A location
approximately 0.5 m aside from the keel may be adequate for
the passage of water between the keel and the transducer. The
figures above and below illustrate external mounting of
transducers on steel hulls and on wood or polyester hulls
respectively.
→ Refer to figure 19 and 20.
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Figure 20 External mounting on wood or polyester hulls
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Transducer blister
Other transducers are designed for installation into the hull or in
a blister. In general, a blister installation is the recommended
method. It brings the transducer below the boundary layer. A
blister is illustrated below.

Figure 21 Transducer blister

Air outlet

Round off corners

Drainage holes
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Transducer
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Water flow

(CD1998)
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The best performance is obtained with a blister height of 40 cm
or more. A streamlined shape and rounded edges reduce the
flow noise. A vertical leading edge or front will guide the
aerated water to the sides of the blister. The orientation of the
blister should follow the water flow. On a conventional hull
shape, without a bulb, the front of the blister should have a few
degrees toe-in towards the bow.
→ See figure 22.
The blister is placed on one of the sides of the hull, and the
distance from the keel is a trade off between a close distance
giving a turbulent flow of water in a narrow passage, and a large
distance bringing the transducer higher up and also more
affected by vessel roll. Normally a distance of approximately 1
m is a good compromise.
→ See figure 23.
The interior of the blister must be filled with sea water. Use
drainage holes in the bottom and an air outlet on the top. The
water pressure behind the transducer will then compensate for
the outside pressure during vessel movements in rough sea.
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The transducer cable penetrates the hull in a stuffing tube, see
the figure above. Leave an adequate loop of the cable behind the
transducer for easy mounting or removal of the transducer.

Figure 22
Blister toe-in

towards the keel

5-8°

Blister

Keel

(CD3018)

Transducer
blisterKeel

Approx
1 m

(CD1996)

Figure 23 Location of blister
relative to the keel
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In a box keel
Vessels with a box keel may use this for transducer installation.
The box keel is already the deepest part of the vessel. If the box
keel is too narrow to accommodate the transducer, it can be
widened, either symmetrically or to one side only. In the last
case the installation could also be described as a blister merged
into the keel. The figure below illustrates a symmetrical box
keel installation.

Transducer

(C
D

30
08

)

Box keel

Figure 24 Symmetrical box keel
installation
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Retractable transducer
Retractable hull units are commonly used for horizontal looking
sonars. When not in use, the transducer is retracted into a trunk.
The retractable hull unit is more expensive than a blister, but on
vessels having a hull where it is difficult or impossible to install
a blister, it may be worth-while. A retractable hull unit with
transducer is shown below.
Vessels without a keel and with a wide, flat bottom is an
example where a retractable hull unit can be the only acceptable
method for bringing the echo sounder transducer below the
boundary layer.

Transducer

(C
D

19
99

)

Keel

Hull
unitFigure 25 Retractable hull unit with

transducer
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Centre board
The use of a centre board with the purpose of stabilising the
vessel is well known. A centre board is also a superior platform
for transducers. Such instrument keels have been built, mainly
on research vessels, with a length of 3 m, protruding also 3 m
below the hull, see the figure below. At that depth, the water is
free of air bubbles up to very high sea states. The vessel is then
able to perform reliable acoustic measurements in open sea a
larger part of the year.

(CD3003)

Instrument 
keel shaft

Lower position

Bottom view

Figure 26 Deep centre board/instrument keel
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Flush mounting in a steel tank
Flush mounting is used on very large vessels with a hull so deep
that no air bubbles are found below the hull, and on vessels
operating in shallow harbours or waters, where a protruding
blister can not be accepted.
The standard procedure for flush mounting on a steel vessel is to
weld a steel tank inside the hull, and mount the transducer into
this tank. As for a blister, the interior of the tank must be filled
with water. This can be accomplished by air release through a
steel tube, which is extended either to open air 1.5 m above the
water line or to the water outside the hull at a point higher than
the tank interior. If the tube is extended to open air, drainage
must be provided with leakage at the transducer flange or a
separate hole in the tank bottom. Transducer mounting in a steel
tank is shown in the figure below.

Figure 27 Flush mounting of
transducer in steel tank

Transducer

Steel tube for
air outlet

Steel tank

Stuffing tube

Water

Drainage hole

(CD3000)
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Behind a protective acoustic window
Vessels operating in arctic waters need special attention on
transducer installation. Floating blocks of ice may damage even
a flush mounted transducer face. For this situation Simrad offers
‘’arctic tanks’’ in different sizes.
The transducer shown in the figure below is mounted inside the
tank behind a strong acoustic window which could be made of
polycarbonate. The tank is oil filled.

Oil inlet

Steel tank

Oil

Acoustic window

(CD3006)

Transducer

Figure 28 Arctic tank with a
protective acoustic window
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Inside the hull
An installation of the transducer inside the hull, and sounding
through the hull, requires a good acoustic contact between the
transducer face and the hull. Build a tank around the transducer
and fill it with a liquid. Oil used in hydraulic systems is a well
suited liquid for this purpose. It contains no gas bubbles and is
non-corrosive.
The tarnsducer can be mounted inside the hull. A substantial
loss must be expected when the sound passes through the hull.
→ Refer to figure 29.

Typical values of the two way loss are 3 dB for polyester, 6 dB
for aluminium and 10 dB for steel. Hulls made of wood or a
sandwich type with foam in the middle, attenuate the sound so
much that through hull sounding must be regarded as
impossible. The loss varies with the distance between transducer
face and the hull. The best result is obtained when the distance
is half a wavelength. Consult Simrad for advice. In addition to
the loss, the beam pattern is degraded, because a larger area of
the hull is set into vibrations.

Figure 29 Transducer mounting inside the hull

Stuffing tube

Transducer

(CD3001)

Air outletHole for oil filling

Oil
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Cable in steel conduit

It is strongly recommended to lay a steel conduit from the
transducer to the echo sounder transceiver, and draw the
transducer cable through the conduit. There are two reasons for
this procedure.

• First, it will make it easier at a later stage to replace the
transducer.

• Second, noise and interference from other electrical
equipment is greatly reduced.

With a steel conduit the installation satisfies the EU regulations
for EMC interference. Without a steel conduit, there is a risk of
reduced echo sounder performance.

Packing nipple

(CD1995)

Ø35

Ø65

Rubber
gasket

Stuffing
tube

Steel tube

Washers

Echo
sounder

Figure 30 Example steel tube arrangement
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The tube should be unbroken and watertight from the transducer
to above the water line. From there, openings or a junction box
can be installed to facilitate drawing of the cable, or to add a
cable extension. However, the tube should act as a continuous
electrical screen all the way and be connected to the transceiver
chassis.
Tube dimensions:
• minimum 35 mm inner diameter

• minimum 6 mm wall thickness (4.5 mm if galvanised).

If two or more transducers are installed close to each other it is
possible to pull their cables in the same steel tube, provided the
tube diameter is increased accordingly. However, for easy
replacement it is recommended that each transducer has its own
steel tube.
Most Simrad transducers are delivered with 20 m cable. Excess
cable can be cut off, or an extension cable can be added. This is
possible because all Simrad transducers have a built-in
transformer for tuning and matching to the cable impedance of
75 Ohms.
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Handling and maintenance
Do not lift the transducer by the cable.
Some transducers are delivered with a cover plate on the face
for protection during transport. Let this plate stay on as long as
possible, but do not forget to remove it before the vessel goes
into the sea.
An anti-fouling paint may be applied to the transducer face.
Because some paint types may be aggressive to the polyurethane
in the transducer face, please consult Simrad’s list of approved
paints on the next page.

Note Arctic tanks have acoustic windows made of polycarbonate.
These must neither be painted nor cleaned with chemicals.

During dry docking of the vessel, the transducer face may be
cleaned for shells and other marine fouling. Be careful not to
make cuts in the transducer face. Use a piece of wood or a very
fine grade emery paper.
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Approved anti-fouling paints
This is Simrad’s list of approved antifouling paints on
polyurethane transducer housing.
From Jotun Paints, Sandefjord Norway:
• Antifouling Seamate HB 33

• Antifouling Seamate HB 66

• Antifouling Seamate HB 99

• Racing

• Non-stop

From International Paints:
• Intersleek tie coat + 425 FCS

- BXA386/BXA390/BXA391 Grey
- HKA563/HKA570/HKA571 Yellow

Mix BXA386, BXA390 and BXA391 first, then apply. When
dry, mix HKA563, HKA570 and HKA571, apply.
From Hempel IFA Coatings AS:
• Hempel A/F Classic 76550

From Jotun-Henry Clark Ltd:
• Anti-fouling Seaguardian

Note Refer to the manufacturer’s documentation and data sheets for a
complete procedure.
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DRAWING FILE
This chapter contains drawings referenced to in other parts of
the manual.
1 GPT Dimensions and mounting:

820-201035 (679-44), Page 193.
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For panel mounting, use countersunk head screws:
M5 machine screws, 4.8 mm plate screws or 5 mm wood screws.

Ved panelmontering benyttes skruer med senkhode:
Maskinskruer M5, 4.8 mm plateskruer eller 5 mm treskruer.

Cut-out 298
Utkapp 298

26
4

11
2.

2 
(C

ut
-o

ut
 1

13
)

84

308

284

25
8

11
2.

2 
(U

tk
ap

p 
11

3)

324

General Purpose Transceiver

Transducer

DSP-6X IO

+5V
+12V
-12V
HV1
HV2

TX
RX

Fuse 10A
115-230 VAC

Fuse 2A

S1
S2

POWER

12
 V

D
C

A
ux

ilia
ry

Et
he

rn
et

Et
he

rn
et

820-201035
Rev.C

Page 1 of 2
(CD5467A) GPT Dimensions and installation



Simrad EQ60

194 857-164342 / Rev.C

820-201035
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Page 2 of 2
(CD5467B) GPT Dimensions and installation

Available for service
Adkomst for vedlikehold

300

Mounting examples
Monteringseksempler

Hints for installation:
- Remember the earth connection on the rear panel.
- All other connections are made on the front panel.
- Try to make the wiring simple.
- Remember to make room for maintenance.
- All maintenance is made from the front.
- The front panel should be visible.

Tips for installasjon:
- Husk jordtilkopling på bakpanelet.
- Alle andre tilkopling gjøres på frontpanelet.
- Tilstreb enkel kabling.
- Husk å lage adkomst for vedlikehold.
- Alt vedlikehold skjer fra fronten.
- La frontplaten være synlig.
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